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KATA PENGANTAR

eterbatasan dalam mencari dan mengelola referensi untuk men-

dukung penulisan tugas akhir merupakan salah satu penyebab

mahasiswa terlambat menyelesaikan perkuliahannya. Selain itu,
tugas akhir yang dihasilkan mahasiswa banyak yang tidak sesuai dengan
harapan. Keterbatasan referensi, dan lemahnya pengetahuan tentang
metode dan cara pengutipan yang baik dan benar merupakan salah satu
penyebabnya. Hal ini berpotensi memicu terjadinya tindakan plagiarisme
dilingkungan kampus. Pemanfaatan aplikasi manajemen referensi dalam
menulis tugas akhir dan laporan penelitian merupakan solusi dari perma-
salahan tersebut.

Zotero merupakan salah satu aplikasi manajemen referensi yang saat
ini paling banyak digunakan, dan direkomendasikan di kalangan akademi-
si. Aplikasi ini sangat andal dalam mengelola referensi ilmiah, yang saat
ini didominasi oleh koleksi elektronik. Aplikasi ini mudah digunakan, dan
tidak berbayar, serta menerapkan sumber terbuka (open source).

Buku ini hadir untuk membantu memudahkan para mahasiswa, dosen,
dan peneliti dalam mencari, mengelola, dan mensitasi referensi guna
penulisan tugas akhir, dan laporan penelitian. Pemanfaatan aplikasi Zo-
tero dalam mendukung kegiatan penelitian dan penulisan tugas akhir,
diyakini akan bermanfaat dalam meningkatkan kualitas hasil penelitian.
Kemudahan yang ditawarkan bisa meningkatkan efektivitas dalam pen-
carian referensi, dan memudahkan dalam mensitasi, serta meningkatkan
produktivitas penelitian.
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I Bab 1

TENTANG ZOTERO

A. MANAJEMEN REFERENSI

Manajemen referensi merupakan proses mengumpulkan, mengor-
ganisasikan, dan mengelola referensi atau sumber daya informasi yang
digunakan dalam penelitian, penulisan ilmiah, atau pekerjaan akademik
lainnya. Dikenal juga sebagai manajemen kutipan atau manajemen sitiran
untuk mendukung peneliti dalam melakukan tiga langkah penelitian da-
sar: mencari, menyimpan, dan menulis (Fenner, 2010). Pemanfaatan apli-
kasi manajemen referensi dalam mendukung penelitian dapat membantu
peneliti dalam menemukan literatur yang relevan, memungkinkan mereka
menyimpan makalah dan metadata bibliografi dalam database pribadi me-
reka untuk digunakan kembali pada saat dibutuhkan, dan memungkinkan
peneliti untuk memasukkan kutipan dan referensi dalam gaya kutipan
yang dipilih saat menulis teks (Gilmour and Cobus-Kuo, 2014).

Manajemen referensi mengelola kutipan yang berasal dari berbagai
macam koleksi seperti: artikel jurnal, buku, dokumen, skripsi, atau sumber
daya lain yang digunakan untuk mendukung argumen, klaim, atau informa-
sidalam penulisan karya ilmiah, atau laporan penelitian. Berikut dijelaskan
manfaat dari manajemen referensi yang menjadikannya sangat penting
dalam dunia akademik, seperti kegiatan penelitian, dan penulisan ilmiah:
1. Meningkatkan akurasi kutipan dan referensi

Penggunaan aplikasi manajemen referensi membantu dalam me-

ningkatkan akurasi dalam kutipan dan pembuatan daftar referensi

yang digunakan dalam sebuah tulisan ilmiah atau laporan penelitian

(Fitriana and Dewi, 2019). Sehingga membantu penulis dalam memas-
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tikan bahwa karya tulis dibuat dengan sah dan sesuai dengan etika
penelitian, serta terhindar dari tindakan plagiarisme.

2. Mengorganisasikan referensi dengan teratur
Aplikasi manajemen referensi memungkinkan pengguna untuk meng-
organisasikan dan mengelola referensi yang mereka miliki dengan
rapi dan teratur. Membantu penulis, peneliti, dan mahasiswa untuk
menjaga keteraturan dalam penyusunan dan pencarian referensi yang
digunakan.

3. Meningkatkan efisiensi dalam pencarian referensi
Dengan mengelola referensi menggunakan aplikasi dengan baik, pe-
neliti dapat menemukan kembali referensi yang relevan dengan cepat
saat mereka membutuhkan sumber daya tersebut dalam penelitian
mereka yang lain. Tentu saja hal ini bisa menghemat waktu dan me-
mudahkan dalam proses penelitian.

4. Meningkatkan kolaborasi
Manajemen referensi memungkinkan peneliti yang tergabung dalam
tim atau kelompok berkolaborasi untuk berbagi dan mengelola refe-
rensi secara bersama-sama. Hal ini bisa meningkatkan efektivitas dan
efisiensi dalam penulisan karya ilmiah atau laporan penelitian.

5. Memelihara dan menyimpan dokumen penting
Tidak hanya metadata, manajemen referensi juga menyimpan doku-
men PDF atau sumber daya yang relevan untuk referensi. Hal ini me-
mungkinkan pengguna untuk menjaga salinan dokumen yang relevan
secara teratur, sehingga tidak perlu mencarinya secara berulang di
kemudian hari.

6. Fleksibilitas dalam penulisan
Aplikasi manajemen referensi, memungkinkan penulis dengan mudah
mengutip dalam berbagai gaya penulisan seperti CMS, APA, MLA,
Chicago, dan lainnya. Hal ini memberikan fleksibilitas dalam penulisan
dan memenuhi persyaratan format tertentu yang mungkin disyaratkan
oleh penerbit atau lembaga.

7. Meningkatkan fokus penulis pada konten penelitian
Manajemen referensi memungkinkan penulis untuk lebih fokus pada
pengembangan ide, konten dan argumen dalam tulisan mereka. Se-
hingga bisa mengurangi gangguan yang mungkin timbul karena ke-
sulitan dalam mencari, mengatur, atau merujuk referensi.
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Secara keseluruhan, manajemen referensi berguna untuk membantu
memastikan integritas penelitian dan penulisan karya ilmiah, meningkat-
kan efisiensi, dan mengatasi kesulitan dalam mengelola referensi dan
kutipan. Keberadaannya sangat penting bagi setiap orang yang terlibat
dalam kegiatan penelitian dan penulisan karya ilmiah.

B. APAITU ZOTERO?

Zotero merupakan salah satu perangkat lunak manajemen referensi
yang paling populer dan paling banyak digunakan saat ini (Rangaswamy
B and Babu H. 2021; Yadav and Mahavidyalaya, 2019). Aplikasi ini dibuat
oleh Roy Rosenzweig Center for History and New Media di George Mason
University (“Credits_and_acknowledgments [Zotero Documentation]”
2023). Memiliki kemampuan yang memungkinkan pengguna untuk me-
rekam informasi kutipan yang relevan, dan menyimpan salinan item asli,
seperti file PDF atau snapshot halaman web, dari berbagai sumber untuk
disimpan dalam database pribadi sehingga dapat digunakan untuk mem-
buat kutipan (Ray, 2017).

Keteraturan dan kecermatan dalam manajemen referensi sangat
diperlukan dalam penulisan karya ilmiah, laporan penelitian, dan tugas
akhir mahasiswa, agar tidak ada referensi yang terlewatkan atau tercam-
pur aduk. Zotero membantu pengguna dalam mengelompokkan referensi
berdasarkan topik, kategori, tema, dan lainnya untuk memastikan bahwa
referensi yang dibutuhkan terkelola dengan baik. Kehadiran Zotero sangat
penting di dunia akademik dan penelitian untuk membantu peneliti dan
mahasiswa mengumpulkan, mengorganisasikan, mensitasi, dan berbagi
referensi dengan lebih mudah dan efisien (Idri, 2015; Yadav and Mahavid-
yalaya, 2019).

Zotero membantu dalam memudahkan proses penulisan. Aplikasi ini
bisa terintegrasi dengan aplikasi pengolah kata seperti: Microsoft Word,
LibreOffice, Google Docs (Yadav and Mahavidyalaya, 2019), sehingga
pengguna dapat menyisipkan kutipan secara otomatis dan membuat
daftar pustaka sesuai dengan gaya penulisan yang diinginkan, dan de-
ngan hasil yang lebih akurat. Hal ini membantu menghemat waktu penulis
(Rangaswamy B. and Babu H., 2021) yang sebelumnya dihabiskan untuk
mengatur kutipan dan daftar pustaka secara manual.

Manfaat yang tak kalah menarik dari aplikasi ini, selain manfaat
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organisasi dan kemudahan penulisan adalah: memungkinkan kolaborasi
yang lebih baik antar penulis/anggota dalam penelitian. Tim penelitian
dapat berbagi koleksi referensi mereka secara online, memudahkan
kolaborasi antar-anggota tim. Zotero juga mengintegrasikan fitur impor
otomatis yang memungkinkan pengguna mengimpor referensi dari ber-
bagai sumber dengan cepat dan mudah. Hal ini membantu peneliti dalam
mengumpulkan referensi dengan cepat dan mengurangi risiko terjadinya
kesalahan dalam pengutipan.

Secara keseluruhan, pemanfaatan Zotero dalam manajemen referensi
akan membantu meningkatkan efisiensi dan kualitas dalam pekerjaan
akademik dan penelitian.

C. APA MANFAAT ZOTERO?

Zotero merupakan aplikasi manajemen referensi yang memiliki ber-
bagai kegunaan dan manfaat, terutama bagi peneliti, mahasiswa, dan
profesional di dunia akademik dan penelitian. Berikut adalah beberapa
manfaat utama dan kegunaan Zotero:

1. Manajemen Referensi yang Efisien

Zotero memungkinkan pengguna untuk mencari sumber informasi,

mengumpulkan dan mengorganisasi referensi dengan mudah. Fitur ini

sangat membantu dalam memperkaya, dan menjaga referensi Anda
agar tertata dengan baik, dan dapat diakses dengan cepat dan mudah.
2. Kemudahan Penulisan

Zotero terintegrasi dengan dengan berbagai perangkat lunak pengo-

lah kata seperti Microsoft Word, LibreOffice, dan Google Docs (Yadav

and Mahavidyalaya, 2019). Hal ini memungkinkan pengguna untuk me-
nyisipkan kutipan, dan membuat daftar pustaka, yang sesuai dengan
berbagai gaya penulisan ilmiah, dengan cepat dan mudah.

3. Impor Otomatis

Anda dapat mengimpor referensi dari berbagai sumber dengan satu

klik seperti: situs temu balik informasi, basis data penerbit, situs web,

katalog online, dan sumber-sumber lainnya. Ini sangat memudahkan
dan menghemat waktu, meminimalkan terjadinya kesalahan dalam
entri data.

4, Memudahkan dalam Mengelola Data Penelitian
Tidak hanya referensi, Zotero juga memungkinkan pengguna untuk
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mengelola data penelitian, seperti gambar, dokumen, dan catatan.
Fungsi ini membantu pengguna dalam mengorganisasi dan memeli-
hara semua elemen yang berkaitan dengan penelitian.

5. Menghemat Waktu
Penggunaan aplikasi manajemen referensi bisa menghemat waktu
Anda dalam mencari, mengatur, dan merujuk referensi secara manual
(Rangaswamy B. and Babu H., 2021). Sehingga memungkinkan Anda
untuk fokus memikirkan konten, dan menyusun laporan penelitian.

6. Memudahkan Kolaborasi
Zotero menyediakan fasilitas berbagi sumber informasi dan koor-
dinasi dalam tim penelitian secara daring. Fungsi ini memudahkan
terjadinya kolaborasi antar sesama tim penelitian.

7. Menghindari Plagiat
Zotero membantu memudahkan Anda dalam pencatatan sumber-
sumber referensi yang digunakan dalam penulisan. Ini merupakan wu-
jud kepatuhan terhadap aturan hak cipta, dan menghindari tindakan
plagiat (Yadav and Mahavidyalaya, 2019).

Pemanfaatan Zotero dapat membantu dalam meningkatkan produk-
tivitas, efisiensi, dan kualitas penelitian, dan penulisan karya ilmiah, serta
tugas akhir mahasiswa (Kiet, 2023). Keberadaan manajemen referensi
sangat membantu dalam menjaga keakuratan dalam pengutipan dan
keberlanjutan kegiatan penelitian ilmiah.

D. KELEBIHAN DAN KELEMAHAN ZOTERO

Sebagai sebuah perangkat lunak, Zotero tentu mempunyai banyak
kelebihan dan kekurangan, yang diperoleh dari hasil perbandingan yang
dilakukanoleh pengguna dengan aplikasi-aplikasi sejenis lainnya. Berikut
dijelaskan kelebihan dan kelemahan Zotero dalam mengelola referensi.

1. Kelebihan Zotero

Layaknya sebuah perangkat lunak pada umumnya, manajemen refe-
rensi Zotero menawarkan beberapa keuntungan bagi pengguna, terutama
dalam hal pengelolaan bahan penelitian dan mengutip sumber referensi.
Berikut dijelaskan beberapa keuntungan yang ditawarkan oleh Zotero,
yang dirangkum dari beberapa sumber (Ray 2017; Puckett 2011):
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a. Gratis
Aplikasi Zotero bisa diperoleh dan diunduh secara gratis melalui web-
site resminya www.zotero.org.

b. Mudah digunakan
Aplikasi Zotero mudah digunakan, karena memiliki antarmuka yang
user-friendly, bahkan bagi pengguna yang baru mengenal software
manajemen referensi sekalipun.

c. Dukungan berbagai platform
Zotero menyediakan dukungan untuk berbagai macam platform, se-
perti desktop, web, dan mobile, yang memungkinkan pengguna untuk
mengakses dan mengelola materi penelitian mereka dari mana saja
dan kapan saja.

d. Pembuatan Kutipan dan Bibliografi Otomatis
Zotero dapat menyediakan fasilitas pembuatan kutipan dan bibliogra-
fi secara otomatis dalam berbagai gaya kutipan, sehingga menghemat
waktu dan tenaga bagi para peneliti.

f.  Kemampuan Kolaboratif
Zotero memungkinkan pengguna untuk berkolaborasi dengan orang
lain dalam proyek penelitian, berbagi materi, dengan menyediakan
fasilitas untuk menyinkronkan perpustakaan mereka di satu atau
banyak perangkat.

g. Manajemen PDF tingkat lanjut
Zotero memiliki fitur manajemen PDF tingkat lanjut, termasuk ek-
straksi otomatis data bibliografi, alat penyorotan dan anotasi, dan
pencarian teks lengkap.

h. Dukungan Komunitas
Sebagaimana layaknya aplikasi-aplikasi open source, Zotero juga me-
miliki komunitas pengguna dan pengembang yang cukup aktif dalam
menyediakan dukungan, dokumentasi, dan Plugin untuk meningkat-
kan fungsionalitas fitur-fiturnya.

2. Kelemahan Zotero

Dari sekian banyak kelebihan yang dimiliki, Zotero juga mempunyai
beberapa kelemahan, diantaranya adalah:
a. Kapasitas Penyimpanan online terbatas

Kapasitas penyimpanan online gratis yang disediakan oleh Zotero
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untuk pengguna terbatas, dan pengguna perlu membeli/melanggan
penyimpanan tambahan jika mereka membutuhkan lebih banyak ru-
ang untuk menyimpan referensi mereka.

Masalah teknis

Terkadang pengguna mengalami masalah teknis dengan Zotero, se-
perti masalah sinkronisasi atau kesalahan dalam mengimpor data dari
database online.

Integrasi terbatas

Zotero tidak sepenuhnya terintegrasi dengan aplikasi pengolah kata
atau perangkat lunak lain, sehingga terkadang pengguna tidak bisa
mengintegrasikan Zotero dengan aplikasi pengolah kata tertentu.
Kecepatan berkurang pada saat jumlah koleksi sudah banyak
Kinerja Zotero akan sedikit melambat dan menjadi kurang responsif
jika Anda memiliki/menyimpan koleksi referensi dalam jumlah yang
cukup banyak.

KOLABORASI ZOTERO DENGAN SUMBER TERBUKA

Zotero telah melakukan kolaborasi dengan berbagai platfom sumber

terbuka guna meningkatkan fleksibilitasnya. Kolaborasi dilakukan dengan
berbagai macam cara, yaitu:

1.

Impor Referensi dari Sumber Terbuka

Zotero memungkinkan Anda mengimpor referensi dari sumber terbu-
ka sepertirepositori dokumen ilmiah, jurnal, dan situs web penelitian.
Anda dapat dengan mudah mengimpor referensi dari sumber-sumber
tersebut ke dalam koleksi Anda menggunakan Zotero Connector atau
fitur Save to Zotero. Hindawi merupakan salah satu jurnal akses ter-
buka yang menyediakan fitur Save to Zotero.

Sharing dan Kolaborasi

Zotero memungkinkan Anda berbagi koleksi referensi dengan rekan-
rekan sesama peneliti secara daring. Kolaborasi bisa dalam bentuk
pengumpulan, pengaturan, dan penggunaan referensi secara bersa-
ma dalam sebuah proyek penelitian.

Kolaborasi dengan Repositori Berbasis Subjek

Zotero dapat digunakan untuk mengorganisasi referensi dari repo-
sitory berbasis subjek yang menerapkan open access. Merupakan
tempat penyimpanan data penelitian dan publikasi ilmiah.
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4.

Terintegrasi dengan Google Books

Pada saat Anda mengekspor kutipan dari sebuah buku, Google Books
secara otomatis bisa mendeteksi keberadaan Zotero Connector, dan
menampilkan menu Save to Zotero. Hanya dengan sekali klik data
referensi tersebut akan langsung tersimpan pada aplikasi Zotero.
Fitur ini sangat memudahkan Anda dalam mengimpor data bibliografi
sebuah koleksi yang ada di Google Books, tanpa perlu meng-copy dan
menyimpannya terlebih dahulu.
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APLIKASI ZOTERO

A. MEN-DOWNLOAD DAN MENGINSTAL ZOTERO

Aplikasi manajemen referensi Zotero berbasis desktop. Untuk meng-
gunakannya Anda harus mendownload dan menginstalnya di komputer
terlebih dahulu. Berbeda dengan aplikasi sejenis, seperti Mendeley, yang
lebih fokus pada versi web/online.

Pada saat digunakan, Zotero membutuhkan dukungan dari aplikasi
lain. Zotero harus terintegrasi dengan web browser (Mozilla, Google Chro-
me, Safari, dan lainnya) untuk mengimpor referensi, dan aplikasi pengolah
kata (Microsoft Word, Libre Office, Office 365, dan lainnya) untuk mensi-
tasi. Relasi ketiganya bisa dilihat pada Gambar 1.

Internet Browser o Word Processor

zotero @

€ F N
P30 i

-~ Impor Mensitasi *~ w

‘ i <~ referensi referensi

GAMBAR 1. CARA KERJA APLIKASI ZOTERO

7|

£

Oleh karena itu, sebelum Zotero digunakan, selain menginstal Zotero,
Anda juga harus menginstal Zotero Connector, penghubung antara Zotero
dengan web browser, dan Microsoft Word Add-ons, fitur Zotero yang di-
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tempatkan pada Microsoft Word untuk mensitasi referensi, dan membuat
daftar pustaka.

10

Men-download Zotero

Untuk men-download aplikasi Zotero ikuti langkah berikut:

Buka laman website Zotero pada laman: https://www.zotero.org.

Klik tombol Download yang ada di bagian tengah halaman situs Zotero.
Setelah itu akan tampil seperti pada Gambar 2. Pada saat buku ini
ditulis, Zotero sudah sampai pada versi 6.

2 e 2

Zotero 6 for Windows Zotero Connector
Your personal research assistant Save to Zotero from your browser

Other platforms

Instal

browsers

GAMBAR 2. HALAMAN DOWNLOAD ZOTERO

Untuk pengguna sistem operasi Windows klik tombol Download yang
ada di bawah Zotero 6 for Windows. Selain itu klik Other Platfoms.
Tunggu sampai proses download selesai.

Setelah itu cari file instalasi pada folder download yang ada di laptop
Anda. Nama file-nya seperti terlihat pada Gambar 2.

~ Today (1)
L) Zotero-6.0.30_setup

GAMBAR 3. FILE DOWNLOAD ZOTERO

Menginstal Aplikasi Zotero

Untuk menginstal aplikasi Zotero ikuti langkah berikut:
Dobel klik file tersebut untuk memulai proses instalasi, setelah itu
akan tampil seperti pada Gambar 4.



1) Zotero Setup

Welcome to the Zotero Setup
Wizard

Itis recommended that you dose all other appiications
before starting Setup. This wil make it possible to update
relevant system fles without having to reboot your
computer.

Click Next to continue,

BAB 2 - APLIKASI ZOTERO

This wizard wil guide you through the installation of Zotera.

1)) Zotero Setup - x
Setup Type r\
ch tup opti %/
oose setup options L \J/

Choose the type of setup you prefer, then cick Next.

(@ Standard
Zotero wil be installed with the most common options.

(O custom

You may choose individual options to be installed. Recommended for experienced users.

GAMBAR 4. PROSES INSTALASI ZOTERO

b. Klik Next untuk melanjutkan - pada layar Select type klik Next.
c. Selanjutnya akan tampil layar konfirmasi, klik Next untuk melanjut-
kan, dan tunggu prosesnya sampai selesai.

<)) Zotero Setup =

Completing the Zotero Setup Wizard

Zotero has been installed on your computer,

Click Finish to dose this wizard.

AL aunch Zofera now!

GAMBAR 5. INSTALASI SELESAI

d. Klik Finish untuk mengakhiri proses instalasi, setelah itu ikon Zotero
akan tampil di layar desktop laptop/komputer Anda, dan Zotero siap
digunakan.

3. Zotero Connector

Zotero Connector merupakan fitur yang sangat berguna untuk meng-
ambil/mengimpor referensi yang tersaji di dalam halaman sebuah situs
web. Selain itu konektor ini juga bisa mendeteksi tipe koleksi yang tersaji
dalam sebuah situs web.

n
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Fungsi Zotero Connector

Berikut adalah beberapa fungsi dari Zotero Connector:
Mengimpor/menyimpan referensi secara otomatis ke dalam Zotero
Zotero Connector memungkinkan pengguna untuk menyimpan ber-
bagai jenis referensi disertai dengan metadata, dan file PDF-nya (jika
tersedia) dari halaman web secara cepat dan otomatis.

Mengambil referensi dari beragam sumber informasi

Zotero Connector mengimpor metadata dari beragam jenis sumber
referensi, seperti e-book, e-journal, skripsi, dokumen, halaman web,
video, audio, dan lain-lain yang tersedia pada berbagai situs web.
Mudah Digunakan

Referensi akan langsung dipindai/tersimpan ke dalam aplikasi Zotero
Anda hanya dengan mengklik ikon Zotero Connector di peramban.
Mengorganisasikan referensi dengan mudah

Pada saat mengklik tombol Zotero Connector, Anda harus menen-
tukan/membuka folder tempat menampung referensi dalam aplikasi
Zotero Anda terlebih dahulu. Sehingga referensi yang disimpan bisa
terorganisasi dengan baik.

Zotero Connector ini sangat bermanfaat memudahkan Anda dalam

mengimpor referensi dari berbagai sumber online. Prosesnya sangat ce-
pat, dan mudah dengan tingkat akurasi yang tinggi.

b.

Menginstal Zotero Connector

Sebelum digunakan, Zotero Connector harus diinstal terlebih dahulu

pada setiap browser yang Anda gunakan, seperti Mozilla, Google Chro-
me, Safari, dan lainnya. Dalam hal ini penulis akan mencontohkan proses

instalasi pada peramban Mozilla Firefox. Untuk peramban lainnya proses
dan caranya hampir sama. Berikut dijelaskan cara menginstalnya:

)
2)

3)

12

Buka aplikasi Zotero - Tools = Install Browser Connector.

Atau bisa juga dengan mencari melalui Google dengan kata kunci
Zotero Connector.

Menginstal melalui aplikasi Zotero ataupun pencarian melalui Google
hasilnya akan sama. Anda akan diarahkan ke halaman instal Zotero
Connector, seperti terlihat pada Gambar 6.
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Install the Zotero Connector for Firefox

Zotero Connectors allow you to save to Zotero
directly from your web browser.

coe =

Not the browser you're looking for? Get Zotero
Show all connectors For Mac, Windows, and Linux

GAMBAR 6. HALAMAN DOWNLOAD ZOTERO CONNECTOR

4) Klik Instal untuk memulai proses instalasi.

wsae  Z zox + v - w wsae | Zzox +v - w
b @ 4 BB = w @ L BRS =

& £ Add Zotero Connector? This extension will have permission to:

Allow www.zotero.org to install an add-on?

» Access your data for all websites

» Access browser tabs

» Access browser activity during navigation
Learn more about installing add-ons safely Learn¥ore

You are attempting to install an add-on from www.zotero.org.
Make sure you trust this site before continuing.

E Continue to Installation Don'tAllow v I Add Cancel

GAMBAR 7. INSTAL WEB IMPORTER MENGGUNAKAN FIREFOX

5) Klik Continue to Installation untuk memulai proses instalasi.

6) Klik Add untuk mengakhiri, setelah itu pada Menu Bar peramban
Anda akan muncul icon Zotero Connector, yang menandakan proses
instalasi telah selesai.

=+ o - X

@ & @ B D

Registﬂl Save to Zotero (Web Page without Snapshot) J

GAMBAR 8. IKON ZOTERO CONNECTOR
Zotero Connector siap digunakan untuk mengimpor/menyimpan re-

ferensi. Lakukan cara yang sama untuk menginstal Connector pada pe-
ramban lainnya.

13
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4. Microsoft Word Zotero Integration/Add-ons

Zotero menyediakan fitur Microsoft Word Add-ons untuk memban-
tu pengguna membuat kutipan, yaitu menu Zotero yang ditampilkan
pada menu utama Microsoft Word. Fitur ini menjembatani antara aplikasi
Microsoft Word dengan Aplikasi Zotero. Add-ons ini kompatibel dengan
hampir semua aplikasi pengolah kata lainnya, seperti Microsoft Word,
LibreOffice, dan Office365.

Pada saat menginstal aplikasi Zotero, Microsoft Word Add-ons sebe-
narnya sudah langsung terinstal. Ditandai dengan tampilnya menu Zotero
pada menu utama Microsoft Word Anda. Seperti terlihat pada Gambar.

File Home Insert Design Layout References Mailings Review View Totero
-1 ﬂ# ﬁ% Document Preferences
‘ Z | [refresh

Add/Edit  Add/Edit Insert i . o
Citation Bibliography ~ Note &7 Unlink Citations
Zotera

GAMBAR 9. ADD-ONS ZOTERO DI MICROSOFT WORD

Tapi pada saat menginstal pada komputer tertentu terkadang menu
tersebut tidak muncul. Untuk mengatasinya, Anda harus memastikan me-
lalui aplikasi Zotero yang sudah terinstal. Caranya adalah sebagai berikut:
a. Pastikan terlebih dahulu aplikasi Microsoft Word Anda sudah tertutup.
b. Buka aplikasi Zotero - Tools - Add-ons
c. lJika Anda menggunakan Microsoft Word, pastikan Zotero Word for

Windows Integration statusnya Disable. Tapi, jika statusnya Enable,

klik untuk mengaktifkannya.

-

Zotero LibreOffice Integration i
Disable
Integrates Zotero with LibreOffice More

Zotero Word for Windows Integration

5 . . Disable
Integrates Zotero with Microsoft Word for Windows More

GAMBAR 10. ADD-ONS MANAGER
d. Jika statusnya sudah Disable, dan Add-ons masih tidak tampil pada

menu utama Microsoft Word, Anda harus mengaktifkannya secara
manual (ikuti petunjuk pada Bab Troubleshooting).

14
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B. HALAMAN DEPAN APLIKASI ZOTERO

Tampilan dan fungsi antarmuka Zotero mirip dengan Windows Explo-
rer, tempat mengelola file komputer berbasisi windows, dan dengan cara
kerja yang tidak jauh berbeda. Antarmuka aplikasi manajemen referensi
Zotero didesain untuk mengelola daftar referensi/koleksi yang dimiliki
oleh pengguna.

Selain menu yang ada di bagian atas halaman, Zotero membagi hala-
mannya ke dalam 3 bagian, yaitu My Library/Collection Pane, daftar doku-
men/references, dan Item Pane (informasi tentang koleksi).

& Duplicate ltems - Zotero

Hle Edit View Tools Help

GAMBAR 11. HALAMAN DEPAN ZOTERO DESKTOP

Berikut dijelaskan menu dan panel/bilah halaman yang membentuk
antarmuka Zotero.

1. Menu My Library/Panel Collection

Menu ini digunakan untuk mengelola dan menampilkan koleksi/refe-
rensi yang Anda miliki berdasarkan kriteria dan kategori tertentu. Menu
ini dibagi menjadi dua bagian yaitu:

a. My Library, merupakan menu yang digunakan untuk menampilkan dan
mengelola referensi yang tersimpan di dalam library/akun Anda

a. My Library (Daftar Koleksi): Menu untuk
menampilkan seluruh daftar referensi yang Anda

5 @~ miliki atau tambahkan ke Zotero.

X My Library b. Duplicate Items: Menu untuk melihat item referensi
yang Anda simpan secara berulang.

c. My Publications: Menu untuk menampilkan hasil
publikasi pribadi Anda.

Eile Edit View Tools Help

| Kemas Ulang Informasi

| Literasi Digital

S cesepr il d. Unfiled Items: Menu untuk melihat item yang yang
My Publications tidak terkategorikan ke dalam folder tertentu.

7 Duplicate lterns e. Trash: Menu ini sama fungsinya dengan Recycle
Unfiled ltems Bin di komputer, yang digunakan untuk tempat

penampungan sementara item-item yang sudah

I3 Trash N i
dihapus sebelum dihapus secara permanen.

GAMBAR 12. MENU MY LIBRARY ZOTERO

15
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2. Halaman Dokumen/Daftar Referensi

Halaman ini merupakan tempat menyajikan/menampilkan, mencari,
dan mengelola referensi yang dimiliki, yang ditempatkan di tengah ha-
laman Zotero. Referensi disajikan berdasarkan kategori yang bisa dipilih
pada menu My Library, di sebelah kiri halaman, seperti: My Library, My
Publications, Duplicate Items, Trash, dan item yang dikategorikan ke dalam
folder tertentu.

@~ B W@ &~ 4 O = All Fields & Tags

Title - Creator Date &

Literasi Digital Untuk Menanggulangi Perilaku Oversharing di... DewiBungaetal.  2022-04-04

Pengaruh Literasi Digital, Media Sosial, dan e-Commerce terh...  Fernando and Ha.., 2022-01-30 -
Persepsi Mahasiswa FTIK tentang Literasi Digital pada Sosial .. Mustika Nur Faid... 2021-10-31 -
Studi Literatur Penggunaan Media Sosial Tiktok Sebagai Sara...  Rahardaya and Ir..  2021-07-11 -

GAMBAR 13. TAMPILAN LIBRARY AS TABLE DESKTOP

Referensi ditampilkan dalam bentuk tabel, yang terdiri dari kolom
title (judul), creator (pengarang), date (tanggal terbit), dan attachments
(lampiran file). Daftar bisa diurutkan berdasarkan kolom-kolom tersebut,
dengan cara mengklik judul masing-masingnya. Perlu dicatat bahwasanya
tidak semua item memiliki lampiran file PDF. ltem yang memiliki lampiran
ditandai dengan tampilnya ikon PDF pada kolom lampiran.

Untuk melihat/membaca lampiran, Anda cukup melakukan double
klik pada baris item yang akan ditampilkan lampirannya. Adapun untuk
melihat metadata/informasi tentang item tersebut, cukup klik baris item
tersebut, dan informasinya akan tersaji pada laman information item di
sebelah kanan layar.

3. Menu Informasi/Panel Items

Menu ini digunakan untuk menyajikan detail data bibliografi item.
Informasi akan tersaji pada saat Anda mengklik salah satu item yang ada
pada daftar. Menu ini memiliki empat sub menu, yaitu: Info, Notes, Tags,
dan Related.

a. Info

Menu ini menyajikan informasi tentang metadata atau data bibliografi
dari sebuah item. Informasi yang tersaji pada menu bisa ditambahkan, dan
diperbaiki secara manual. Untuk lebih jelasnya bisa dilihat pada Gambar 14.

16
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Info  Notes Tags Related a. Info: Menu untuk menampilkan informasi
metadata koleksi

ftem Tpe Jounal Aricle o b. Notes: Menu untuk membuat catatan
Title Literasi Digital Untuk Menanggulangi Perilaku RS . o .
Oversharing di Media Sosial tentang intisari, dan kesimpulan isi dari
~ Author DewiBunga S sebuah koleksi/referensi
~ Author Cokerde Istri Dian Laksmi Dewi = c. Tags: Menu yang memungkinkan Anda
~ Author Kadek Ary Purnama Dewi =) &

memberikan label pada referensi
untuk memudahkan pencarian dan
pengelompokan

{..) Abstract Media sosial memberikan fasilitas bagi warga...
Publication Sevanam: Jurnal Pengabdian Masyarakat
Volume 1

lesue 1 d. Related: Menu yang memungkinkan Anda
Pages 1-12 mengumpulkan beberapa koleksi/item
Date 2022-04-04 ymd yang dianggap berhubungan

GAMBAR 14. HALAMAN INFORMATION/INFO PANE

4. Menu Toolbar

Menu toolbar terletak di bagian atas antarmuka Zotero, fungsinya
menyediakan akses cepat ke fungsi-fungsi utama Zotero. Ada beberapa
tombol yang disediakan yang terdiri dari: tombol untuk membuat folder/
kategori baru, menambahkan item baru, menambahakan catatan/note
baru, mencari referensi, mencari lokasi sumber referensi, dan menyin-
kronkan koleksi. Berikut dijelaskan fungsi dan penggunaan menu-menu
yang ada pada toolbar tersebut:

File Edit View Tools Help

: 6
[01@,2 30-2454- % - )7]
v [ My Library A Title
[| ~ open access & X: % ~9 10 € ]
Date # | Info  Notes Tags Related

GAMBAR 15. TOOLBAR ZOTERO

Berikut dijelaskan fungsi dari setiap menu pada Gambar 15, sesuai
dengan nomor yang tertera:

1) New Collection: Menu untuk menambahkan folder/sub folder baru
yang digunakan untuk mengelompokkan item/koleksi.

2) New Library: Menu untuk membuat grup baru pada akun Zotero online,
dan News Feed untuk berlangganan penelitian/terbitan terbaru dari
jurnal, situs web, penerbit, institusi, kelompok penelitian, atau sum-
ber lain sehingga Anda bisa menemukan artikel atau karya terbaru
dengan cepat.

17
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3)

18

New item: Menu ini digunakan untuk menambahkan item/referensi
secara manual. Secara garis besar penambahan item dikelompokkan
ke dalam 2 jenis, yaitu penambahan item secara manual, dan penam-
bahan file yang tersimpan di dalam komputer/laptop Anda.

Add item by identifier: Menu ini digunakan untuk menambahkan item/
referensi menggunakan nomor identitas koleksi seperti: ArXivID, DOI,
ISBN, dan lain-lain. Zotero bisa membantu mencarikan data bibliogra-
finya selama data itu tersedia atau bisa ditemukan.

New Note: Menu ini digunakan untuk menambahkan catatan atau
anotasi pada item yang ada pada daftar referensi.

Add Attachment: Menu ini digunakan untuk menambahkan file lam-
piran pada daftar referensi yang sudah tersimpan di dalam aplikasi
Zotero.

Advanced Search: Merupakan fitur pencarian tingkat lanjut yang di-
sediakan oleh Zotero. Fitur ini membantu memudahkan dalam mencari
referensi yang Anda miliki menggunakan berbagai kategori pencarian,
seperti judul, pengarang, penerbit, tahun terbit, lampiran, dan teknik
pencarian lainnya.

B Advanced Search - [m} x

Search in library: | My Library

Match all v~ of the following:

Title ~| | contains .

[ search subcollections [ Show only top-level items
[ Include parent and child items of matching items

Clear Save Search

Title Creator

GAMBAR 16. ADVANCED SEARCH

Advanced Search akan sangat bermanfaat ketika Anda melakukan
pencarian pada saat sudah menyimpan referensi dalam jumlah ba-
nyak di dalam Zotero.
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MENAMBAHKAN DAN MENGIMPOR
REFERENSI MENGGUNAKAN ZOTERO

A. MENAMBAHKAN REFERENSI KE ZOTERO

Setelah memahamitentang aplikasi Zotero, daftar menu yang dimiliki,
antarmuka, dan fitur-fiturnya, selanjutnya kita akan mencoba menambah-
kan referensi ke dalam aplikasi tersebut. Secara umum ada dua metode
untuk menambahkan atau menyimpan referensi ke aplikasi Zotero yaitu:
(a) penambahan manual melalui Aplikasi Zotero Desktop; dan (b) meng-
gunakan Zotero Connector. Berikut dijelaskan cara penambahan untuk
masing-masingnya.

1. Penambahan Secara Manual

Untuk menambahkan koleksi secara manual, Zotero menyediakan
beberapa pilihan, yaitu: entri data referensi manual, penambahan file yang
tersimpan di dalam komputer, dan menggunakan identifier.

a. Entri Data Referensi

Menu ini digunakan untuk menambahkan item/referensi secara ma-
nual. Metode ini biasanya dilakukan untuk menambahkan referensi yang
berasal dari dokumen tercetak, yang tidak memiliki softcopy/dokumen
PDF atau metadata elektronik. Untuk menambahkan item secara manual
ikuti langkah berikut:

1) Klik toolbar Add item © - - pilih tipe koleksi yang akan ditambahkan,
atau bisa melalui Menu File > New item - pilih jenis koleksi yang
akan ditambahkan.
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2) Pilih Book, jika ingin menambahkan buku, atau tipe koleksi lainnya.

@v /5 ...g‘ J‘| -]

[ Book (
Document ate the Google Form Submission K

Journal Article gle Form Sebagai Alat Evaluasi Pembelajaran ... P

Thesis engine optimization, tools and techniques 5

gle's Web-Based Applications and Services B

Video Recording

Link to File...
Store Copy of File..

More b

GAMBAR 17. MENU NEW ITEM

3) Setelah itu Anda diminta menambahkan metadata/data bibliografi
buku yang ada di sebelah kanan layar (menu information). Seperti
terlihat pada Gambar 18.

B - [}

Info  MNotes Tags Related

Item Type Book
Title

~  Author (last), (first)
Abstract
Series
Series Number
Volume
# of Volumes
Edition
Place
Publisher
Date

GAMBAR 18. MENU INFORMATION

4) Entrikan secara manual data-data yang dibutuhkan pada kolom-kolom
yang tersedia.

b. Menambahkan File (Store Copy of File)

Sub menu ini digunakan untuk menambahkan item berupa dokumen
PDF yang tersimpan di dalam komputer/laptop Anda. Untuk menambah-
kannya ikuti langkah berikut:
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1) Klik toolbar Add item © ~ - pilih store copy of file
2) Setelah itu Anda diminta untuk memilih file yang akan ditambahkan
di dalam komputer Anda.

4 & » ThisPC > Downloads v o Search Downloads
Organize ~ Mew folder B> O @
A Name Dste modified
A Quick access
~ Today (3)
@ OneDrive - Persor
Googles 28/11/2023 06:19
I This PC 10.1080913645579.2020.1805550 28/11/2023 06:15
J 3D Objects the-new-trend-for-search-engine-optimi... 28/11/2023 06:11
B Desktop v Yesterday (12)
2] Documents 2587-Article Text-9260-2-10-20190116
& Downloads 21408-Article Text-66497-1-10-20220804
b Music Digital Library Management System Vinn... 2
2 .
e REAMI JOWITA_DLMS Kel. 7(1)

@E TUGAS PERPUSTAKAAN DIGITAL_MUHA...
Digital Library Management System-Kelo...
Astikel Tugas Kelompok 4 pemakaian Zot... 2

v < >

B videos

. Windows (C:)

= Data (D)

| |AllFiles v

T
GAMBAR 19. MEMILIH ITEM

[EELE TR 10.1080@13645579.2020.1803550)

3) Klik Open untuk menambahkan file, setelah itu metadata file yang
ditambahkan akan diekstraksi oleh Zotero. Hasilnya seperti terlihat
pada Gambar 19.

Title Creator Date - |

5 An Application to Automate the Google Farm Submission Kaur et al. 2022-10 .

Pemanfaatan Aplikasi Geogle Form Sebagai Alat Evaluasi Pembelgjaran ... Pane et al. 2022-06-26 -

| = The new trend for search engine optimization, tosls and techniques Shahzad et al. 2020-06-01 -
= Shahzad et al. - 2020 - The new trend for search engine optimization, ..

The new trend for search engine optimization, tools and techniques Shahzad et al. 2020-06-01 -

Taking Advantage of Google's Web-Based Applications and Services Brigham 04/2014 -

GAMBAR 20. HASIL IMPOR STORE COPY OF FILE

Jika tipe file yang ditambahkan berasal dari artikel jurnal atau e-book
yang diterbitkan oleh jurnal nasiohal terakreditasi atau

Jurnal internasional bereputasi, biasanya metadatanya akan diek-
straksi dengan baik oleh Zotero.

c¢. Penambahan Referensi Menggunakan Identifier

Menu ini digunakan untuk menambahkan item/referensi mengguna-
kan nomor identitas koleksi seperti: ArXivID, DOI, ISBN, dan lain-lain. Zote-
ro bisa membantu mencarikan data bibliografinya selama data itu tersedia
atau bisa ditemukan. Untuk menggunakannya ikuti langkah berikut:

1) Klik menu add item by identifier.
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2) Selanjutnya Anda diminta mengentrikan nomor identitas koleksi,
seperti terlihat pada Gambar 21.

@-A B- &4

Title Crastar
& An  Enter ISBNs, DOls, PMIDs, ar¥iv IDs, or ADS Bibcodes to add to your library: 1l
Per || | al.

~ The eti

** Shahzad et al. - 2020 - The new trend for search engine optimization, ...

GAMBAR 21. KOLOM ENTRI ADD IDENTIFIER

3) Entrikan nomor identitas, seperti DOI, ISBN, dan lainnya > Enter.
Misalnya entrikan salah satu ejournal dengan nomor DOI: 10.31445/
jskm.2021.3591

Jika nomornya sesuai, dan koleksinya ditemukan secara otomatis ko-
leksi/item baru akan ditambahkan ke daftar referensi Anda sesuai dengan
nomor identitas yang dientrikan.

d. Menambahan Lampiran Dokumen

Referensi yang sudah tersimpan di dalam Zotero sebagian hanya
berupa metadata/data bibliografi saja. Jika Anda memiliki file lampiran-
nya, seperti file PDF full text, atau dokumen pendukung lainnya, Zotero
menyediakan fitur khusus untuk menambahkannya, yaitu melalui menu
Add Attachment.

Ada tiga pilihan cara yang disediakan dalam menambahkan lampiran,
seperti terlihat pada Gambar.

GGUN... x AMALISIS PEMANFAA.. X Academic library mar... X Architecture For Femi.., X Analisis b

B~ A k- {,;:-‘ L )~ Title, Cre
e |e) Attach Linkta URL... Creator Date
Why Do We Us Attach Stored Copy of File... elnstagram Us... Asrila and Kurniawan  2023-06-22
& AnApplication o Attach Linkto File.. n Kaur et al. 2022-10

Pemanfaatan Aplikasi Google Form Sebagai Alat Eveluasi Pembelajaran .. Pane et al. 2022-06-26

GAMBAR 22. MENU ADD ATTACHMENT

Berikut dijelaskan langkah-langkah untuk menambahkan lampiran:
1) Pilih atau klik referensi yang akan ditambahkan lampirannya pada
halaman daftar referensi - Klik toolbar Add Attachment
2) Bisajugadengan mengklik kanan item refernsi - Add Attachment.
3) Pilih salah satu dari tiga jenis lampiran yang akan ditambahkan.
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m  Attach Link to URL

Sub menu inidigunakan untuk menambahkan lampiran dalam bentuk
link ke URL tempat file atau lampiran tersimpan. Untuk menambahkan
lampiran, kita diminta mengentrikan link URL tempat lampiran disimpan.

O~ A B #£-| 4
Title Creator
‘Why Do We Use Instagram? Motives of Active and Passive Instagram Us...  Asrila and Kurniawan

2" An Application to Automate the Google Form Submission Kaur et al,

« 2] Pemanfaatan Aplikasi
“* Full Text PDF

~ The new trend for seal
¥ Shahzad et al. - 202

The new trend for seal

Taking Advantage of Cancel

Attach Link to UR| X

Link: ‘http:/.frapository.um-ma\ang.ac‘id."wﬁﬁf |

Title: ‘ Sub Maodul Tarknmplemanl |

GAMBAR 23. ATTACH LINK TO URL

Dalam hal ini kita hanya menambahkan tautan link-nya saja ke dalam
referensi yang ada pada daftar, tanpa menyimpan file lampiran ke dalam
aplikasi.

= Attach Stored Copy of File

Sub menu ini digunakan untuk menambahkan file lampiran yang
tersimpan di dalam komputer ke dalam referensi. Berbeda dengan sub
menu stored copy of file pada menu New item, yang referensinya belum
dientrikan sama sekali. Pada sub menu ini kita menambahkan file lampiran
ke dalam referensi yang sebelumnya sudah tersimpan di dalam aplikasi
Zotero.

m  Attach Link to File

Sub menu ini digunakan untuk menambahkan link ke file lampiran
yang tersimpan di dalam komputer, tanpa menyimpannya di dalam apli-
kasi. Berbeda dengan sub menu Attach Stored Copy of File, yang menam-
bahkan file sebagai lampiran. Pada sub menu ini kita hanya menambahkan
link ke file lampiran yang tersimpan di dalam komputer. Tujuannya adalah
untuk mengurangi duplikasi, dan menghemat ruang penyimpanan di da-
lam komputer Anda.

2. Menambahkan Referensi Menggunakan Import Library

Sub menu ini digunakan untuk mengimpor daftar referensi, berupa
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file hasil ekspor yang berasal dari aplikasi lain. Zotero bisa mengimpor
file yang disimpan menggunakan format tertentu, seperti BibTex, End-
noteXML, RIS, dan format lainnya. Berikut dijelaskan cara mengimpor
referensi menggunakan import library:

a. Import File

Ada beberapa tipe file yang bisa diimpor oleh Zotero seperti: BibTex,
RIS, Zotero RDF, dll. Untuk mengimpornya ikuti langkah berikut:
1) Klik File = Import > setelah itu Anda akan diberikan pilihan, seperti
pada Gambar 24.

Import X

Where do you want to import from?

@A file (BibTeX, RIS, Zotero RDF, etc)

(O Mendeley Reference Manager (online import)

< Back Cancel

GAMBAR 24. MENU IMPORT FILE

2) Klik menu File > Next - pilih file yang akan diimpor.

Import X
4 @ > Search Results in Documents v O ris y
Organize = E~- O @
N = 5
# Quick access export
CA\Users\regis\Documents
@, OneDrive - Persor T S
literasidigital
B This PC CA\Users\regis\Documents\P...
1 3D Objects S LITERASI ANAK
I Deskiop Ci\Users\regis\ Documents\P...
[ Documents T computintell No preview available.
& Downloads CAUsers\regis\Documents\P...
b Music ™ quantummecanic
] Pictures CAUsers\regis\Documents\P
& videos M compmodelling
£, Windows (€] CAUsers\regis\Documents\P
= Data (D) v '—‘ datamining v
File name: |export | [anFites v

=
GAMBAR 25. MEMILIH FILE UNTUK DIIMPOR
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Selanjutnya Anda akan diberikan pilihan.

Import X

Options

Place imported collections and items into new callection

File Handling
@ Copy files to the Zotero storage folder

O Link to files in original location

Linked files cannot be synced by Zotero

< Back Cancel

GAMBAR 26. OPSI PLACE IMPORTED

Mengaktifkan opsi Place imported collection and items into new
collection berarti koleksi yang akan kita impor akan ditempatkan di
dalam folder baru secara terpisah.

Pada pilihan File Handling

a) Jika Anda memilih Copy file to the Zotero storage folder maka
seluruh file lampiran yang dimiliki oleh koleksi yang akan diimpor,
selain data bibliografi koleksi, seluruh file diambil dan disimpan
di dalam aplikasi Zotero Anda.

b) Jika Anda memilih Link to files in original location, maka file lam-
piran tidak akan diambil, hanya data bibliografi, dan link menuju
lampiran yang akan menyertai koleksi/referensi yang diimpor.

Untuk menghemat media penyimpanan sebaiknya Anda memilih opsi

kedua.

Selanjutnya klik Next = Finish untuk mengakhiri proses impor kolek-

si/referensi.

Setelah itu daftar referensi Anda akan bertambah, sebanyak data

referensi yang tersimpan di dalam file yang diimpor. Kita bisa me-

nambahkan lebih dari satu referensi sekaligus, tergantung jumlah
referensi yang tersimpan di dalamnya.
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LATIHAN 1
1.

Entrikan data referensi sebuah buku yang Anda miliki secara manual ke dalam
aplikasi Zotero.

Impor file PDF sebuah artikel jurnal yang tersimpan di dalam komputer Anda
menggunakan store copy of file

Impor file PDF artikel yang tersimpan di dalam komputer Anda menggunakan
link to file.

Tambahkan sebuah referensi dengan nomor DOI: 10.14203/j.baca.v40i2.476 ke
aplikasi Zotero Anda menggunakan Add identifier

Tambahkan sebuah file PDF untuk dijadikan lampiran ke dalam salah satu refe-
rensi yang sudah Anda buat

Download file hasil ekspor yang berisi daftar referensi melalui link: https://s.
id/1XF82

Tambahkan file tersebut ke dalam aplikasi Zotero Anda menggunakan import
library.

B.

MENGIMPOR DARI MENDELEY REFERENCE MANAGER

Jika sebelumnya Anda memiliki akun pada aplikasi manajemen refe-

rensi Mendeley, maka data/referensi yang tersimpan di dalam akun terse-
but bisa langsung diimpor ke dalam Zotero. Caranya ikuti langkah berikut:

1.

26

Klik menu File - Impor - pilih opsi kedua, Mendeley Reference Ma-
nager > Next.
Setelah itu Anda diminta memasukkan username dan password Men-
deley, seperti pada Gambar 27.

Import x

Welcome to the Import

Please enter your credentials to log in to Mendeley Reference Manager. This is
necessary to import your Mendeley library into Zotero.

Zotero will never see or store your Mendeley password.

< Back Next > Cancel

GAMBAR 27. MENGIMPOR DATA DARI ZOTERO
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3) lJika username dan password yang dientrikan benar, maka setelah itu
Anda diminta menentukan lokasi tempat menyimpan referensi.

Import x

Options

[Place imported collections and items into new collection

< Back Cancel
GAMBAR 28. OPSI PENYIMPANAN REFERENSI

4, Centang opsi Place imported collections and items into new collec-
tion untuk mengimpor data ke dalam folder baru, jika tidak koleksi/
referensi yang Anda impor akan ditempatkan di dalam My Library
tergabung dengan koleksi lainnya yang sudah Anda miliki. Hasilnya
seperti terlihat pada Gambar 29.

v [ My Library Title
B Imported 11/29/2023, &:38:23 PM Requirements of Digital Archiving in Saudi Libraries in the Ligh
| Kemas Ulang Informasi Motif Khalayak dalam Mengakses Konten Berita di Instagram F

—| Perilaku Pengguna Media Sosial Zero Waste Management: Investigation of Green Technology, t

| Tambah Felder Zero Waste Management: Investigation of Green Technology, t
| Waste Management Effective Medical waste management for sustainable green he
| Kemas Ulang Informasi Lecturers' information literacy experience in remote teaching ¢
Kesehatan Mental Anak Remaja Modeling the process of personal digital archiving through ub

GAMBAR 29. HASIL IMPOR MENDELEY REFERENCE MANAGER

Seluruh referensi yang diimpor disimpan dalam folder yang diberi
nama “Imported + tanggal diimpor.” Di dalamnya referensi disimpan sesuai
dengan struktur data pada saat disimpan dalam akun Zotero Anda.

C. MENGIMPOR REFERENSI MENGGUNAKAN ZOTERO
CONNECTOR

Zotero Connector merupakan ekstensi/fitur yang ditempatkan pada
browser/peramban web, memungkinkan pengguna menyimpan referensi
yang tersaji pada halaman web secara langsung ke akun Zotero Anda.
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1.

Fungsi dan Manfaat Zotero Connector

Ada beberapa manfaat dan kemudahan yang ditawarkan kepada

pengguna saat menggunakan Zotero Connector:

a.

Mudah dalam menyimpan referensi

Zotero Connector secara otomatis mampu mendeteksi tipe koleksi,
dan metadata dari halaman web yang dikunjungi, seperti judul, pe-
ngarang, dan tahun publikasi, dan lainnya. Hanya dengan sekali klik
pada ikon Zotero Connector yang muncul di bilah peramban, pengguna
dapat menyimpan referensi dari halaman web tersebut.

Menyimpan berbagai jenis materi

Zotero Connector mampu mendeteksi referensi yang tersaji pada
halaman web sebuah peramban, seperti: artikel jurnal, buku dan bab
buku, situs web, dan jenis dokumen lainnya untuk disimpan ke dalam
aplikasi Zotero.

Mampu berintegrasi dengan berbagai peramban

Zotero Connector kompatibel dengan berbagai peramban web, seperti:
Google Chrome, Mozilla Firefox, Safari, dan lainnya.

Dengan beberapa kemudahan yang ditawarkan Zotero Connector,

menjadikan alat ini yang sangat berguna untuk mengumpulkan dan
mengelola referensi secara efisien guna mendukung proses pencarian
referensi penelitian.

2.

Mengimpor Referensi

Berikut dijelaskan langkah-langkah dalam mengimpor referensi

menggunakan Zotero Connector.

a.

28

Pastikan pada peramban Anda sudah terinstal Zotero Connector, yang
ditandai dengan tampilnya ikon Save to Zotero pada sudut kanan atas
browser. Seperti terlihat pada Gambar.

+ v ‘— X

@ & DB S =

GAMBAR 30. IKON WEB IMPORTER

Tampilan ikon bisa berbeda-beda tergantung informasi yang sedang
terjadi pada laman peramban Anda.
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Pastikan aplikasi Zotero Anda aktif/terbuka.

Buatkan folder khusus (New Collection) untuk menampung referensi
yang akan Anda cari di aplikasi Zotero.

Lakukan pencarian referensi, dalam hal ini saya akan mencontohkan
melakukan pencarian menggunakan Google Scholar (https://scholar.
google.com). Saya mencari artikel dengan kata kunci “kesehatan
mental anak remaja”. Hasil pencariannya seperti terlihat pada Gam-
bar 31.

kesehatan mental anak remaja n

0.1 sec)

Pentingnya Kewaspadaan Berinternet untuk Kesehatan Mental Anak dan
Remaja
¥ Yuliana - Jurnal limu Medis Indonesia, 2022 - penerbitgoodwood com

masalah kesehatan mental di antara anak-anak muda. Hal ini ... menyebabkan peningkatan
masalah kesehatan mental, namun . sosial terhadap gejala kesehatan mental secara internal.
7r Save 90 Cite Cited by 8 Related articles &%

Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor Yang
Mempengaruhi: Literature Review
N Aisyaroh, | Hudaya... - ... of Islamic and ..., 2022 - prosiding islamicmedicine or.id

. PKPR merupakan pelayanan pada remaja yang diberikan .. kesehatan jiwa remaja. meliputi:
masalah psikososial, gangguan jiwa, dan kualitas hidup termasuk dalam deteksi kesehatan .
¥r Save DU Cite Cited by 7 Related articles All 2 versions %

Pola Asuh Orangtua, Motivasi & Kedisiplinan dalam Meningkatkan Kesehatan
Mental Remaja Papua
AC Mustamu, NH Hasim... - durnal Keperawatan ..., 2020 - jurnal.umb.ac.id

. kesehatan mental remaja dengan nilai signifikansi (0.000 <0,005). Disiplin, motivasi belajar
berpengaruh terhadap kesehatan mental remaja ... kesehatan mental pada 80 siswa remaja ...
¥r Save 99 Cite Cited by 26 Related articles All 3 versions 9%

Literature Review Of Factors Related To Mental Health In Adolescent: Kajian
Literatur Fakior Yang Berhubungan Dengan Kesehatan Mental Pada Remaja
F Ulya - Journal of Health and Therapy, 2021 - journal. mrcrizquna.com

GAMBAR 31. HASIL PENCARIAN GOOGLE SCHOLAR

Selanjutnya Anda bisa langsung meng-import hasil pencarian terse-
but ke dalam akun Zotero, baik secara kolektif maupun satu per satu.

Mengimpor Referensi Secara Kolektif

Hasil pencarian Google Scholar ataupun mesin pencarireferensiilmiah

lainnya seperti: Moraref, Portal Garuda, Science Direct, DOAJ, dan lain-lain.
bisa diimpor secara kolektif atau dalam jumlah banyak sekaligus. Untuk
mengimpornya ikuti langkah berikut:

a.

Klik Ikon Zotero pada sudut kanan atas layar. Hasilnya seperti terlihat
pada Gambar 32.

29



MASTERING ZOTERO:
PANDUAN KOMPREHENSIF MANAJEMEN REFERENSI UNTUK PENELITIAN DAN PENULISAN KARYA ILMIAH

&1q=kesehatan+mental +anak+rem B iy Lo = B

)

2 ension: (Zotero Connector) - Zotero ltem Selector — Mozilla Firefox s

ct which items you'd like to add to your library: a

[[] Pentingnya Kewaspadaan Berinternet untuk Kesehatan Mental Anak dan Remaja
[ Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor Yang Mempenagaruhi: Literature R | library
Pola Asuh Orangtua, Motivasi & Kedisiplinan dalam Meningkatkan Kesehatan Mental Remaja Papua
Literature Review Of Factors Related To Mental Health In Adelescent. Kajian Literatur Faktor Yang Berh
T[] PENDIDIKAN KESEHATAN ORANGTUA TENTANG COVID-19 TERHADAP KESEHATAN MENTAL REMA
D [PDF][FDF] Peranan Kesehatan Mental Remaja Saat Pembelajaran Daring Pada Masa Pandemi
"] Pemanfaatan Program Implementasi Promosi Kesehatan: Promosi Kesehatan Mental Pada Remaja
1yeb D Dukungan sosial teman sebaya dan masalah kesehatan jiwa pada remaja
mei|[] Pembinaan Kesehatan Mental Remaja Di MTS Mgalaban Desa Bendet Kecamatan Diwek Jombang
") Penyuluhan kesehatan tentang kesehatan jiwa pada remaja

i

1]

< >

A0\ ——
| Selpct All || Deselect All | | cancel || oK |

icine4 3

GAMBAR 32. DAFTAR REFERENSI YANG AKAN DIIMPOR

b. Pilih koleksi yang akan diimpor, dengan mencentang opsi di samping
judul. Atau klik Select All untuk mengimpor seluruh koleksi. Dalam
hal ini saya memilih tiga buah referensi untuk diimpor.

c. Klik OK untuk mengakbhiri.

d. Bukaaplikasi Zotero Anda, dan lihat hasilnya pada Folder yang sedang
aktif.

e. Seluruh koleksi yang Anda pilih akan tersimpan di dalam folder Ke-
sehatan Mental Anak Remaja dalam aplikasi Zotero, seperti terlihat
pada Gambar 33.

File Edit View Tools Help

s @ 0- 4 - #-|a
v (@ My Library Title
I Imported 11/29/2023, 8:38:23 PM Trend Penelitian Kesehatan Mental Remaja Di Indenesia Dan Faktor Yan...
Kemas Ulang Informasi Literature Review OFf Factors Related To Mental Health In Adolescent: Ka...
~| Kesehatan Mental Anak Remaja Pola Asuh Qrangtua, Motivasi & Kedisiplinan dalam Meningkatkan Kes...
_| LITERASI ANAK

| Motivasi Pengguna Instagram
| Preservasi Digital
My Publications

 Duplicate ltems

GAMBAR 33. HASIL IMPOR ZOTERO CONNECTOR
Ada tiga referensi yang masuk ke dalam folder Kesehatan Mental

Anak Remaja, sesuai dengan jumlah referensi yang saya pilih pada saat
mengimpor.
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4. Mengimpor Referensi Satu Per Satu

Jika Anda ingin melihat terlebih dahulu detail informasi referensi yang
akan diimpor, Anda bisa memilih/mengklik salah satu koleksi/referensi
hasil pencarian. Ada dua kemungkinan yang terjadi:

a. Andadibawa menuju ke website tempat koleksi tersebut berada. Jika
referensi tersebut sesuai dengan kebutuhan, Anda tinggal mengklik
Zotero Connector pada sudut kanan layar browser untuk mengim-
pornya, atau

b. File PDF koleksi tersebut akan langsung di-download dan tersimpan di
dalam komputer Anda. Kalau seperti ini, Anda tinggal menambahkan
file tersebut secara manual menggunakan menu New item - Store
copy of file.

5. Mengimpor Halaman Website

Proses import referensi menggunakan Zotero Connector tidak hanya
sebatas koleksijurnal atau buku elektronik saja, tetapi juga berlaku untuk
tipe koleksi lainnya, seperti e-skripsi, video, audio, halaman web, dan lain-
lain. Dalam hal ini saya mencontohkan proses mengimpor berita yang ada
di halaman website, seperti terlihat pada Gambar 34.

<« c O B httpsy/unpacid/pages/tantang visi m B om L m B RS

Telpon: 07517058632

@ ety

Home | Pages | Tentang Visi Misi

VISI, MISI DAN TUJUAN

VISI
Menjadi Universitas Bermartabat dan Bereputasi Internasional

MISI

1. Melaksanakan pendidikan berkualitas internasional;

2. Melaksanakan penelitian inovatif dan publikasi global;

3. Melaksanakan pengabdian kepada masyarakat untuk memecahkan masalah dan berkontribusi bagi
pembangunan bangsa Indonesia;

4. Menerapkan tata kelola universitas kelas dunia; dan

5. Melaksanakan kerja sama internasional.

GAMBAR 34. MENGIMPOR HALAMAN WEB
Prosesnya impornya sama seperti yang dijelaskan pada Gambar 30.

Klik tombol Zotero Connector untuk mengimpor koleksi. Setelah itu secara
otomatis datanya akan tersimpan ke dalam Zotero sesuai dengan folder
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tujuan. Zotero bisa menerima dan membedakan tipe koleksi referensi yang
tersaji pada halaman sebuah situs web.

Satu hal yang perlu diingat, Zotero belum tentu bisa melakukan ek-
straksi atau mendeteksi metadata/informasi bibliografi dari setiap refe-
rensi yang disimpan dengan sempurna. Seperti terlihat pada Gambar 34.

D = Title, Creat

@~ A By £+ &

Title Creator Date
Effective Medical waste management for sustainable green healthcare Lee et al. 2022
Circular economy appreach in solid waste management system to achieve UN-5DGs: ... Sharma et al.

Q Universitas Megeri Padang | Official Website Padang

GAMBAR 35. HASIL IMPOR HALAMAN WEB

Kolom tahun tidak terisi. Hanya 1dari 3 item yang ada tahun terbitnya.
Untuk itu setelah referensidisimpan perlu dipastikan terlebih dahulu, apa-
kah metadata yang diekstrasioleh Zotero sudah benar atau sesuai dengan
yang tercatat di dalam koleksi sumbernya (dokumen aslinya). Jika tidak
sesuai/tidak lengkap harus diperbaiki secara manual, agar informasinya
menjadi valid.

LATIHAN 2
1. Impor e-jurnal dari Google Scholar menggunakan Zotero Connector minimal 5
item.

2. Impor sebuah file artikel jurnal (format PDF) yang tersimpan di dalam komputer
Anda menggunakan menu New [tem --> Store copy of file.

3. Impor sebuah berita dari website salah satu koran nasional.
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MENGORGANISASIKAN REFERENSI
MENGGUNAKAN ZOTERO

A. MENGORGANISASIKAN REFERENSI

Collection dan sub collection digunakan untuk mengorganisasikan
referensi yang Anda simpan di dalam aplikasi Zotero. Agar referensi
yang Anda miliki tersimpan dan tertata dengan baik, sebaiknya daftar
referensi yang dimiliki diorganisasikan/dikelompokkan berdasarkan tema
atau topik penelitian. Selain itu juga bisa membantu memudahkan dalam
melakukan pencarian terhadap referensi yang Anda miliki.

Referensi diorganisasikan pada menu MyLibrary yang ada di sebelah
kiri halaman Zotero.

1. Membuat Collection/Folder Baru

Ada 2 cara yang bisa digunakan untuk membuat Folder, yaitu meng-
gunakan Toolbar menu pada bagian atas halaman, dan menu File pada
menu utama.

a. Menggunakan Toolbar Menu

Untuk membuat folder menggunakan Toolbar ikuti langkah berikut:
1) Buka aplikasi Zotero, dan perhatikan Toolbar menu seperti pada Gam-
bar 36.

z My Library - Zotero
Eile Edit Miew TJools Help

g @~ @ ~ £5 g T j1-| b
= My Library Title

GAMBAR 36. MENU TOOLBAR
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2) Klik New Collection untuk membuat folder baru = Tulis nama folder
-> OK.

3) Setelahituakan terbentuk folder baru sesuai dengan nama yang Anda
ketik pada menu My Library.

b. Menggunakan Menu Utama
Berikut dijelaskan cara membuat folder menggunakan menu utama

Zotero.

1) Klik menu File > New Collection.

2 My Library - Zotero

'roh nl Llmmlbls L Aslal b b LLI a1
File Edit Yiew Tools Help ] New Collecti %
e s p- isip| NewCo ection
New Note le aky|
New Collection... ) .
oo Re ipe 0 Enter a name for this collection:
Close Ctrl+W M '
Export PDF = B
Import... Ctrl+Shift+1 7e
Impert from Clipboard - Ctrl+ Shift+ Alt+| pe licd Cancel
Export Library.. Ef' Jica
e
Edit . -
2 m sia Dini dalam Keluarga Murhayati 2019

GAMBAR 37. MENU MY LIBRARY ZOTERO DESKTOP

Entrikan nama koleksi/folder yang akan dibuat.
Setelah itu folder baru akan terbentuk pada menu My Library.

Mengorganisasikan Koleksi/Folder
Pada tahap ini kita akan mengelola folder yang sudah dibuat, dan

mempelajari cara memanfaatkan fitur klik kanan pada menu My Library
Zotero. Seperti terlihat pada Gambar 38. Ada 7 sub menu yang bisa kita
pilih pada saat sebuah folder di klik kanan.

34

2 Kesehatan Mental Anak Remaja - Zotero
File Edit View Tools Help

s @~ ©- A @~ #-| 2
~ [ My Library Title
I Imported 11/28/2023, 8:38:23 PM Trend Penelitian Kesehatan
| Kemas Ulang Informasi Literature Review Of Factor
- T S U Y e
| LTERASIANAK o NewSubcollection...
) Motivasi Penggunz | Rename Collection...
=) Presenvasi Digital | pejere Collection..
My Publications  \FE8¥ Delete Collectionand feme
7 Duplicateltems
. Unfiled ltems ¥ Export Collection...
Sl Trash i= Create Bibliography from Collection...
1= Generate Report from Collection...
[l Feeds

GAMBAR 38. MENU KLIK KANAN
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Selanjutnya kita akan membahas satu per satu dari sub menu terse-

but.

a. New Subcollection: digunakan untuk membuat sub folder atau folder
baru di dalam sebuah folder. Cara membuatnya sebagai berikut:

1)  Pilih sebuah folder - Klik kanan > New Subcollection - buat
nama folder baru - OK.

2) Setelahituakan terbentuk folder baru didalam folder yang dipilih.

b. Rename:digunakan untuk mengganti nama folder. Cara menggantinya
ikuti langkah berikut.

1)  Pilih folder yang akan diganti namanya - Klik kanan - Rename
collection > Buat nama baru - OK.

2) Setelah itu nama folder akan berubah, sesuai dengan nama baru
yang sudah dibuat.

c. Delete Collection: digunakan untuk menghapus folder, tetapi itemnya
tetap tersimpan di dalam My Library. Cara menghapusnya ikuti lang-
kah berikut:

1)  Pilih folder yang akan dihapus = Klik kanan = Delete collection
- Klik Delete Collection pada menu konfirmasi.

2) Setelahitu folder akan terhapus, tetapi referensi yang tersimpan
di dalamnya tidak ikut terhapus, bisa dilihat di dalam My Library.

d. Delete Collection and Items: digunakan untuk menghapus folder dan
seluruh item yang tersimpan di dalamnya. Cara menghapusnya ikuti
langkah berikut:

1)  Pilih folder yang akan dihapus - klik kanan > Delete collection
and items - Klik Delete Collection and Items pada menu konfir-
masi.

2) Setelah itu folder dan seluruh referensi yang ada di dalamnya
akan terhapus, dan berpindah ke dalam Trash, sebelum dihapus
secara permanen.

e. Export Collection: digunakan untuk mengekspor folder dan seluruh isi-
nya ke dalam format file tertentu. Cara mengekspornya ikuti langkah
berikut:

1) Pilih folder yang referensinya akan diekspor = Klik kanan =
Export collection.

2) Setelahituakan tampil menu konfirmasi seperti pada Gambar 39.
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cupid

ak| Export.. X

Format: | RIS b
Translator Qptions
Export Notes
Export Files
[1include Annotations
Character Encoding:
Unicode (UTF-8) i

Cancel

GAMBAR 39. MEMILIH FORMAT FILE

3) Tentukan format file hasil Export dan opsi data yang akan dieks-
por pada Translate Option.

4) Untuk format file, cukup banyak pilihan yang disediakan. Jika
ingin mengekspor untuk digunakan pada aplikasi manajemen
referensi lain, pilih format RIS, atau BibTex. Jika ingin dibuka
menggunakan Excel pilih format CSV.

5) Untuk opsi Translate Option, format CSV tersedia beberapa pilih-
an:

a) Export Note: aktifkan jika Anda hanya akan mengekspor data
bibliografi/metadanya.

b) Export File: aktifkan jika Anda ingin mengekspor files lampir-
an

c) Include Anotations: aktifkan jika Anda ingin menyertakan se-
luruh anotasi yang sudah dibuat pada referensi.

d) Aktifkan semuanya jika Anda ingin mengekspor seluruh re-
ferensi yang ada di dalam folder tersebut beserta file lampir-
an dan anotasi yang sudah dibuat.

f.  Create Bilbiography from Collection: sub menu ini digunakan untuk
membuat daftar bibliografi/daftar pustaka dari referensi yang ada
dalam sebuah folder.

1)  Pilih folder yang akan dibuat daftar pustakanya = Klik kanan =
Create Bilbiography from Collection.
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Create Citation/Bibliography e

il Citation Style:

American Chemical Society s
American Medical Association 11th edition

American Political Science Association

American Psychological Association (APA) Tth edition

American Sociological Association (ASA) bth edition

Chicago Manual of Style 17th edition (author-date)

Chicago Manual of Style 17th edition (full note)

~

hicano Maniial af Shila 17th adi "
Manage Styles...

Language: | English (US) ~

Output Mode:

() Citations

@ Bibliography
Output Method:

(O Save as RTF

O Save as HTML

@® Copy to Clipboard

Q Print

Cancel

GAMBAR 40. MEMILIH CITATION STYLE

Pilih citation style/model kutipan dari daftar pustaka yang akan
dibuat. Dalam hal ini saya memilih Chicago Manual Style (CMS).
Pada kolom Output Mode pilih citation jika Anda ingin membuat
kutipan, atau bibliography jika Anda ingin membuat daftar pusta-
ka.

Tentukan output method, hasil akhir dari bibliografi yang akan
dibuat, apakah akan disimpan, di-copy atau langsung dicetak.
Dalam hal ini saya memilih copy to clipboard - OK.

Selanjutnya buka Microsoft Word - Paste.

Hasilnya seperti terlihat pada Gambar 41.

Basyiroh, L. 2017, “Program Pengembangan Kemampuan Literasi Anak Usia Dini
Pendidikan Guru Paud Stkip ... no. Query date: 2023-10-11 15:07:56. hitp-/ie-
journal stkipsiliwangi ac id/index php/tunas siliwangi/article view/646

Hewi, L. 2020. “Penzembangan Literasi Anak Melalui Permainan Dadu Literasi.” Tufla, no. Query date:
2023-10-11 15:07:56
hittps://s lar.archive.. A gaa daglt A iainkudus.a
id/index php/thufula/aticle/download/7238/pdf

Khairil, K, F§ Siregar, and E Suprayemo. 2020. “Budaya Literasi Anak Melalui Cerita Rakyat Sumatera Utara
Di Kampung Nelayan Seberang.” JURNAZ PRODIKMAS Hasil ..., no. Query date: 2023-10-11 15:07:56.
‘https-//jurnal umsu ac.id‘index.php/; i icle/view/5756.

Novitasari, K. 2019. Teknologi Pada Pembel Literasi Anak Usia Dini.” Jurnal
Golden Age, no. Query date: 2023-10-11 15:07-56. htp:/fe-
fournal ac.id/index.php/iga/article/view/1435.

Nurbacti, N, A Mayasari, and O Arifudin. 2022 “Penerapan Metode Bercerita Dalam Meningkatkan Literasi
Anak Terhadap Mata Pelajaran Bahasa Indonesia* Jurnal Tahsinia, no. Query date: 2023-10-11 15:07:56.
https-//furnal ac id/index php/ths/articleview/328.

Nurhayati, R. 2019. “Membangun Budaya Literasi Anak Usia Dini Dalam Keluarga.” Nuansa Akademik:
Jurnal Pembangunan Masyarakat, no. Query date: 2023-10-11 15:07:36
hittps://jurnal uey ac.id/index pt ik/arti 918.

Robiah, R, H Hendarman, and ... 2023. “Evaluasi Program Literasi Anak Dengan Pendekatan Model CIPPO.”

al Pendidikan Anak ..., no. Query date: 2023-10-11 15:07:56.

t1ps://vrww. murhum ppipaud.org/index. php/murhum/article view/262.

Saputri, K, and N Nurhaidah. 2017. “Faktor-Faktor Yang Mempengaruhi Literasi Anak Kelas 1 SD Negeri 20
Banda Aceh.” Elementary Education Research, no. Query date: 2023-10-11 15:07-56
hittp://jim usk.a. i 2537,

iyaningsih, G, and A 2019. “Peng Media Big Book Untuk Meningkatkan Kemampuan
Literasi Anak Usia 5-6 Tahun.” Scholaria: Jurnal Pendidikan .... no. Query date: 2023-10-11 15:07:36.

Program Stud

GAMBAR 41. DAFTAR BIBLIOGRAFI/DAFTAR PUSTAKA
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Pada halaman Microsoft Word Anda akan terbuat daftar pustaka yang
berisi seluruh daftar referensi yang tersimpan di dalam folder yang
dibuat bibliografinya. Daftar pustaka akan tersusun sesuai dengan
style yang dipilih pada poin b).

g. Generate Report from Collection: sub menu ini digunakan untuk mem-
buat laporan, yang berisi data bibliografi referensi yang ada di dalam
folder. Untuk menyajikannya ikuti langkah berikut:

1) Pilih folder yang referensinya akan dicetak = Klik kanan > Ge-
nerate report from collection

2) Setelah itu laporan akan tersaji pada halaman baru, seperti terli-
hat pada Gambar 42.

2 Zotero
File Edit

Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor

Yang Mempengaruhi: Literature Review

Item Type Journal Article
Author Noveri Aisyarch
Author Isna Hudaya
Author Ratna Supradewi
Date 2022
Short Title Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor Yang
Mempengaruhi
Library Catalog Google Scholar
URL hitps://prosiding.islamicmedicine.or.id/index.php/iiicm/article/view/6
Accessed 11/29/2023, 9:25:17 PM
Volume
Pages 41-51
i Scientific dings of Islamic and C Medicine
Issue 1
Date Added 11/25/2023, gi25:20 PM
Modified 11/2g/2023, g:25:20 PM

Attachments

o Available Version (via Google Scholar)

GAMBAR 42. MENCETAK LAPORAN BIBLIOGRAFI

3) Selanjutnya Anda bisa menyimpan atau mencetak data bibliografi
tersebut sesuai dengan kebutuhan.

3. Mengorganisasikan Daftar Referensi

Zotero menggunakan istilah My Library untuk tempat menampilkan
dan mengorganisasikan daftar referensi yang dimiliki oleh pengguna.
Menu ini disediakan untuk memudahkan pengguna mengelola referensi
yang dimiliki agar bisa tertata dengan baik. Daftar referensi tersebut
dapat dikelola/diorganisasikan dengan cara mengalokasikannya ke
dalam folder tertentu.
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Untuk mengalokasikan referensi ke dalam folder tertentu ikuti lang-

kah berikut:

a. Pilih referensi yang ada pada daftar.
b. Klik tahan dan geser referensi yang dipilih > lepaskan di atas folder

tujuan.

c. lJika ingin memilih lebih dari satu referensi, pilih referensi dengan
menekan CTRL atau SHIFT pada keyboard = klik/pilih referensi yang
akan dialokasikan = klik tahan = geser dan lepaskan di folder tujuan.

& Kesehatan Mental Anak Remaja - Zotero
Fle Edit View Tools Help

N @~
~ (3 My Library
~ Imported

11/29/2023, 8:38:23 Pg

[ Kesehatan Mental Anak Remaja

O- £ @~ -4
Title

Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor Yan...

Creator Date.
Aisyaroh et al, 202

|7 Uiteratire Review O Factors Related To Mental Health In Adolescent: Ka... Ulya 2001

[/ LITERASI ANAK

Pola Asu Orangtus, Motivasi & Kedisiplinan dalam Meningkatkan Kes...

Mustamu et sl 2020

GAMBAR 43. MENGALOKASIKAN REFERENSI

Sebuah referensi yang dimasukkan ke dalam folder lain dengan cara
di atas tidak akan menghilangkan referensi tersebut dari folder asalnya.

4. Memanfaatkan Klik Kanan dalam Mengelola Daftar Referensi

Referensi yang ada dalam daftar bisa dikelola secara langsung meng-
gunakan klik kanan pada mouse. Ada banyak fasilitas yang tersedia pada
saat kita menekan klik kanan, seperti: membuka file PDF, menandai, eks-
por, menghapus dokumen dan lain-lain. seperti terlihat pada Gambar 44.

@~ A B~ £-]a
Title

Trend Penelitian Kesehatan

T Open PDF in New Windouw
@ View Online
[ ShowFile

Pola Asuh Orangtua, Motiv

[E Show in Library

& AddNote
Add Note from Annatations
& Add Attachment

Add te Collection

"5 Remove ltem from Collection...

¥ Exportktem...
i= Create Bibliography from Item...

I Generate Report from Item...

Creator

GAMBAR 44. FITUR KLIK KANAN REFERENSI
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Beberapa dari menu yang ada pada Gambar 44 sudah dibahas pada
bab sebelumnya (mengorganisasikan folder). Oleh karena itu berikut ini
kita akan membahas fungsi-fungsi yang tidak terdapat pada fitur klik
kanan folder.

a. Open PDF: membuka file PDF yang tersimpan di dalam referensi yang
ditampilkan di dalam aplikasi Zotero

b. Open PDF in New Window: menampilkan file PDF yang tersimpan di
dalam referensi yang ditampilkan di jendela baru.

c. View online: membuka halaman website tempat referensi diterbitkan.

d. Show file: Menampilkan file PDF yang tersimpan di dalam komputer
tempat data Zotero disimpan.

e. Show in library: Menuju/menampilkan referensi yang tersimpan di
dalam My Library.

f.  Add note: menambahkan catatan pada koleksi/referensi.

g. Add attachment: menambahkan lampiran pada referensi (lihat bab
menambahkan lampiran dokumen).

h. Add to collection: menambahkan referensi ke dalam folder tertentu.

Caranya cukup dengan klik kanan referensi = pilih folder tempat

folder akan dimasukkan.

Y- A @ F-| A z
e Creater Date
Trend Penelitian Kesehatan Mental Remaja Di Indonesia Dan Faktor Yan...  Aisyaroh et al. 2022
Literature Review Of Factors Related To Mental Health In Adolescent: Ka... Ulya 2021
Pela Asuh Orangtua, h* s o ’Kesm Mustamu et al. 2020

................................... = Gpen PDF

= Open PDF in New Window

View Online

- ShowFile

B Showin Library

& Add Note
Add Note from Annotations
& Add Attachment >
Add to Collection > New Collection...
"5 Remove Item from Collection... e T
1
¥ Duplicate ltem Kesehatan Mental Anak Remaja
51 Move ltem to Trash... LITERAS! AMAK
¥ Export ltem... Preservasi Digital

Create Bibliography from Item...

mioj

Generate Report from ltem...

GAMBAR 45. SUB MENU ADD TO COLLECTION
Selain menambahkan ke dalam folder yang sudah ada, koleksi juga

bisa ditambahkan ke dalam folder baru dengan cara memilih New Col-
lection. Fungsi dan kegunaan dari sebagian fitur yang terdapat pada
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menu klik kanan referensi, seperti: remove item from collecton, move itu
to trash, export item, create bibliography from item, dan generate report
from item, sama dengan fitur klik kanan folder yang dijelaskan pada
bab sebelumnya. Perbedaannya hanya pada ruang lingkupnya. Kalau
folder perintah yang diberikan berlaku terhadap semua referensi yang
tersimpan dalamnya. Adapun pada daftar referensi, hanya untuk satu
referensi yang dipilih saja.

B. MENGATUR DAN MEMPERBAIKI METADATA REFERENSI

Pada saat mengimpor referensi menggunakan Zotero Connector, tidak
semua metadata yang dihasilkan sesuai dengan informasi yang sebenar-
nya. Tingkat validitas metadata yang paling tinggi biasanya dihasilkan
dari koleksijurnal elektronik, terutama yang diterbitkan oleh jurnal-jurnal
internasional bereputasi, dan jurnal nasional bereputasi. Adapun untuk
tipe koleksi lainnya biasanya informasi metadata yang dihasilkan sering
tidak valid atau tidak lengkap. Oleh karena itu, kita tidak bisa terlalu
mengandalkan hasil ekstraksi metadata dari Zotero. Harus diperiksa dan
diperbaiki jika ada data yang salah atau kurang.

Biasanya informasi referensi hasil ekstraksi yang paling sering tidak
lengkap adalah tahun terbit. Pada Gambar 46 terlihat, dari 4 referensi
yang ada didalam daftar hanya 3 referensi tidak ada tahunnya. Sedangkan
untuk penulis/creator ada 1 referensi yang kosong.

|0~ £ B~ %4 o -
Title Creator Date

Effective Medical waste management for sustainable green healthcare Lee et al. 2022

} Tersangka Korupsi Kembalikan Uang Rp 7,5 Miliar, Dibungkus 8 Plastik

Iaterial flow analysis and life cycle assessment of solid waste manage..  Thushari et al.

Circular econory approach in solid waste management system to achi..  Sharma et al.

GAMBAR 46. CONTOH METADATA YANG TIDAK LENGKAP

Untuk memperbaiki metadata sebuah referensi, ikuti langkah berikut:
1. Klik judul koleksi yang akan diperbaiki metadatanya.
2. Selanjutnya akan tampil informasi metadata pada layar sebelah
kanan. Terlihat ada kesalahan pada kolom Author (berisi tahun), dan
kolom Date/tahun yang masih kosong.
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Title Crea.. Dater & Info  Notes Tags Related
Effective Medical waste management for sustainable.. Leee.. 2022
Tersangka Korupsi Kembalikan Uang Rp 7,5 Miliar, Di... Item Type Journal Article
Material flow analysis and life cycle assessment of so..  Thus... Title Material flow analysis and life cycl
Circular econormy approach in solid waste managem...  Shar.. management in urhan green area:
= Author Thushari, |
« Author ... JVicheanteab - Sustainable
* Author 2020, undefined
Abstract

Publication sustainenvironres biomedcentral .
Valume
Issue
Pages
Date

Series

GAMBAR 47. TAMPILAN INFORMASI METADATA

3. Perbaiki data yang salah (author), dan tambahkan data yang masih
kosong (date).

4. Untuk kolom-kolom lainnya silakan tambahkan/perbaiki sesuai de-
ngan kebutuhan.

C. MEMBUAT ANOTASI PADA DOKUMEN

Zotero memudahkan Anda dalam membubuhi keterangan pada artikel,
termasuk menambahkan sticky note atau sorotan (highlighting). Catatan
ini dilampirkan ke kutipan instan di menu utama Zotero, dan disinkronkan
di seluruh platform sehingga mudah dilihat pada aplikasi (Trout, 2016).
Keterangan atau catatan pada artikel hanya bisa dibuat untuk referensi
yang tersedia file PDF (full text)-nya.

Untuk membuat anotasi pada dokumen Zotero, ikuti langkah berikut:
1. Pilih dan double klik judul koleksi yang akan dibuat anotasinya.

Q- S T~ | —4 | * Title, Creator, Year
Title Creator Date x
Literature Review Of Factors Related To Mental Health In Adolescent: Kajian Lit..  Ulya 2021 ']
J

Erzangka RoTapsi Rembalikan Uang Rg 7,3 Wiliar, DiBungkas ¢ Plasti

Material flow analysis and life cycle assessment of solid waste management in ... Thusharie...

GAMBAR 48. MEMILIH REFERENSI UNTUK DIBUAT ANOTASI

2. Bisajugadengan cara: Klik kanan salah satu kolom referensi = Open
File, setelah itu file PDF akan langsung terbuka.
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Literature Review Of Factors... X

5 1 of 20
Email: J410170161 @student.umsr,ac.id

NI &
a
=

Abstrak
Remaja merupakan masa periode transisi antara masa anak-anak ke mas
memformulasikan identitas mereka ketika dewasa, dimana remaja rem:
perubahan-perubahan yang terjadi pada tubuhnya, mengembangkan pikiran-pil
mudah terangsang secara erotis sehingga berpengaruh terhadap kesehatan
Tujuan: melakukan kajian literatur dari berbagai jurnal untuk menjelaskan fak
;ll?erhubuugan dengan kesehatan mental pada remaja. Metode yang digunakar
iteratur menggunakan dua database yaitu google scholar dan Pubmed menggun:
“kesehatan mental”, “mental ”, “kesehatan mental” remaja, mental heal
“factor related «, “faktor yang bupgan”, associated factor. Hasil: Sebanya
telah ditelaah menjelaskan terdapat lu gan yag signifikan antara Game onlir
Pola Asuh Orang Tua, Lingkungan Teman Sebaya, Sholat Dhuha terhadap ke
pada remaja. Kesimpulan: Kesehatan mental pada remaja sangat rendah, ter
faktor yang beragam sehingga diperlukan upaya pencegahan utamanya k
merupakan sarana yang utama. Saran bagi peneliti selanjutnya dapat melak
dengan analisis multivariat dan dapat mengkaji berbagai faktor lain yang berhu
kesehatan mental pada remaja serta mencantumkan definisi operasional variabel
dan jelas.

GAMBAR 49. HALAMAN PEMBUATAN ANOTASI

Cari kalimat yang akan ditandai atau dianotasi.

Pilih warna dengan mengklik Select Color (1) - klik highlight (2) >
sorot teks yang akan ditandai (3).

Klik Note (4) atau Klik Kanan = Add to note untuk menambahkan
catatan.

Lakukan secara berulang untuk membuat anotasi lainnya.

Untuk menampilkan anotasi pada daftar referensi, klik kanan judul re-
ferensi = pilih Add note from annotations seperti terlihat pada Gambar
50.

Title Creator Date

Literature Review Of Factors Related To Mental Healt” ., ~ - e 2021
Tersangka Korupsi Kembalikan Uang Rp 75 Miliar, D P

Open PDF in New Window
View Online

- Show File

Material flow analysis and life cycle assessment of s¢

(= Show in Library

& Add Note
Add Note from Annotations

& Add Attachment >
Add to Collection >

Remove ltem from Collection...
Duplicate Item

Move Item to Trash...

Export ltem...

reate Bibliography from Item.

= Generate Report from ltem..

GAMBAR 50. NOTES DAN ANOTASI
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8. Setelahitujudul anotasi yang dibuat akan tampil di bawah judul refe-
rensi (lihat Gambar 51). Hasinya juga akan tersaji pada laman informasi
yang ada di sebelah kanan.

Title Crea.. | Dater & MR LTS MQ

|~ Literature Review Of Factors Related To Mental Health In.. Ulya 2021 5

| Annotations (11/30/2023, 4:35:27 PM) »
= Available Version (via Google Scholar) Annotations
Tersangka Korupsi Kembalian Uang Rp 7,5 Miliar, Dibu. (11/30/2023, 4:35:27 PM)

Material flow analysis and life cycle assessment of solid .. Thush

“iteratur menggunakan dua database yaitu google scholar dan
Pubmed menggunakan kata kund “kesehatan mental”, "mental
health”, “kesehatan mental” remaja, mental health “adolescent,
“factor related ", “faktor yang berhubungan”, associated factor.
Hasi: Sebanyak 6 jurnal yang teleh ditelaah menjelaskan terdapat
hubungan yag sgnifkan antara Game onine, Relgiostas, Pola Asuh
Orang Tua, Lingkungan Teman Sebaya, Sholat Dhuha terhadap
kesehatan mental pada remaja. Kesmpulan: Kesehatan mental pada
remaja sangat rendah, terdapat berbagai faktor yang beragam
sehingga diperlukan upaya pencegahan utamanya keluarga karena
merupakan sarana yang utama.” (Ulya, 2021, p. 27) kesimpulan.

(Ulya, 2021, p. 27) keterangan

GAMBAR 51. HASIL ANOTASI

9. Selain itu Anda juga bisa membuat anotasi secara menyeluruh atau
kesimpulan yang menjelaskan isi dari sebuah artikel/dokumen pada
kolom New standalone note, seperti terlihat pada Gambar 52.

@~ A |~ #~ | &4 | O ¥ Title, Creator, Year
Title New Standalone Note | Crea.. Dater &
w Literatu Add Child Note Jental Health In... Ulya 2021 g

| Annotations (11/30/2023, 2:35:27 PM)
= Available Version (via Google Scholar)
Tersangka Korupsi Kembalikan Uang Rp 7.5 Miliar, Dibu..,

Material flow analysis and life cycle assessment of solid ..  Thush...

GAMBAR 52. MENU NOTE

10. Adapun untuk menghapus Note, tinggal klik judulnya = pilih Move
item to trash.

D. MENGEKSPOR LIBRARY

Export library merupakan salah fitur yang disediakan oleh Zotero guna
membantu pengguna untuk saling berbagi referensi, dan menggunakan
referensi di perangkat yang berbeda. Fitur ini digunakan untuk meng-
ekspor keseluruhan referensi yang Anda miliki untuk disimpan ke dalam
format tertentu.

Untuk mengekspor referensi yang tersimpan dalam aplikasi Zotero
ikuti langkah berikut:
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1. Klik menu file = Export library.

z Kemas Ulang Informasi - Zotero
File Edit View Tools Help

MNew ltem *  EReview Of Factors.. X

New MNote v A B u-;,;_‘ 3
Mew Collection...

lod S Literature Review Of Factors Relat
Import... Ctrl+Shift+| Tersangka Korupsi Kembalikan Ua
Import from Clipboard  Ctrl+ Shift+Alt+| Material flow analysis and life cyc
Export Library...

Exit

77 Duplicate ltems

GAMBAR 53. EXPORT MENGGUNAKAN ZOTERO DESKTOP

2. Selanjutnya kita akan diminta menentukan tipe file, dan opsi lainnya,
seperti terlihat pada Gambar 54.

e s

ak Export.. X

Format: | RIS -
Translator Options
Export Notes
Export Files
[linclude Annotations
Character Encoding:

Unicode (UTF-8) e

Cancel

GAMBAR 54. OPSI EXPORT LIBRARY

3. Tentukan format file hasil Export dan opsi data yang akan diekspor
pada Translate Option.

4. Untuk format file, cukup banyak pilihan yang disediakan. Jika ingin
mengekspor untuk digunakan pada aplikasi manajemen refensi lain,
pilih format RIS, atau BibTex. Jika ingin dibuka menggunakan Excel
pilih CSV.

5. Untuk opsi Translate Option, tersedia beberapa pilihan:

a. Export Note: aktifkan jika Anda hanya akan mengekspor data
bibliografi/metadanya.
b. Export File: aktifkan jika Anda ingin mengekspor files lampiran
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c. Include Anotations: aktifkan jika Anda ingin menyertakan seluruh
anotasi yang sudah dibuat pada referensi.
d. Aktifkan semuanya jika Anda ingin mengekspor seluruh referensi
yang ada di dalam folder tersebut beserta file lampiran dan ano-
tasi yang sudah dibuat.

LATIHAN 3

1. Buat minimal 3 buah folder baru, dan setiap folder minimal memiliki 1 sub fold-
er dan beri nama sesuai dengan bidang ilmu Anda/tema penelitian yang akan
Anda lakukan.

2. Alokasikan seluruh referensi yang sudah tersimpan di dalam aplikasi Zotero
Anda ke dalam folder yang sudah Anda buat sesuai dengan temanya.

3. Buat anotasi pada salah satu file PDF referensi yang Anda miliki.
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MENSITASI MENGGUNAKAN
ZOTERO

A. ADD-ON ZOTERO DI MICROSOFT WORD

Untuk mensitasi referensi pada Zotero, Add-ons Zotero harus sudah
terinstal pada aplikasi pengolah kata yang Anda gunakan seperti: Mic-
rosoft Word, Libre Office, dan lainnya. Add-ons ini menjadi salah satu
menu utam Microsoft Word, yang berguna untuk menghubungkan antara
Ms. Word dengan Zotero. Tampilannya seperti terlihat pada Gambar 55.

H -0 E\ i Zotero A5 Desktop - Wor-

File Insert

Design Layout References

Mailings Review Viev

Home

5] é7 ‘:‘Z‘Ducument Preferences
Z Z L [2Refresh

Add/Edit Add/Edit  Inset

Citation Bibliography = Mote 2 Unlink Citations

Zotero

GAMBAR 55. FITUR PLUGIN ZOTERO MICROSOFT WORD

Berikut dijelaskan fungsi dari fitur-fitur yang ada pada Add-ons Zo-

tero:

1. Add/Edit Citation: menu ini digunakan untuk menambahkan referensi
yang akan disitasi ke dalam tulisan.

2. Add/Edit Bibliography: menu ini digunakan untuk membuat daftar
pustaka, sesuai dengan referensi yang sudah disitasi/ditambahkan
sebelumnya

3. Insert Note: menu ini digunakan untuk menambahkan anotasi yang
sudah dibuat pada salah satu referensi.
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4. Document Preferences: menu ini digunakan untuk mengubah/meng-
ganti citation style atau format pengutipan.

5. Refresh: menu ini digunakan untuk meng-update daftar pustaka, se-
telah dilakukan penambahan atau perubahan terhadap referensi yang
disitasi.

6. Unlink Citations: menu ini digunakan untuk memutuskan hubungan/
koneksi antara kutipan dengan aplikasi Zotero atau referensi yang
tersimpan di dalam aplikasi Zotero.

B. MEMBUAT SITASI MENGGUNAKAN ZOTERO

Untuk mensitasi referensi dan membuat daftar pustaka menggunakan
Zotero, Anda harus memastikan bahwasanya referensi yang akan dikutip
sudah tersimpan di dalam Zotero. Setelah itu dilanjutkan dengan menge-
tik naskah. Setiap kali mensitasi referensi yang tersimpan dalam Zotero,
pastikan aplikasi Zotero di komputer/laptop Anda sudah terbuka/aktif.

Selanjutnya kita akan mencoba mempraktikkan bagaimana cara men-
sitasi menggunakan Zotero. Saya sudah mempunyai sebuah naskah yang
akan digunakan untuk mengutip referensi yang sudah tersimpan dalam
aplikasi Zotero, seperti terlihat pada Gambar 56.

Dalam dunia akademik dan penelitian, manajemen referensi merupakan salah satu komponen pendu-
kung yang sangat dibutuhkan oleh peneliti untuk mengautomatisasi pengelolaan dan pengutipan refe-
rensi untuk ( 1 ) kelancaran proses penelitian dan penulisan laporan akhir. Peneliti, mahasiswa, dan pro-
fesional sering kali kesulitan dalam mengelola tumpukan referensi, artikel, dan dokumen yang mereka
miliki. Terkadang mereka menghabiskan banyak waktu hanya untuk mencari referensi secara berulang,
mensitasi, dan membuat ( 2 ) daftar pustaka.

Padahal saat ini sudah banyak aplikasi manajemen referensi yang bisa

h N

tu hkan da-

lam membuat laporan penelitian, dan tugas akhir. Salah satu perangkat untuk yang paling populer

dan paling banyak direkomendasikan untuk gelola referensi adalah Zotero, yang merupakan me-
dia untuk memfasilitasi mahasiswa dan peneliti dalam mengutip dan merujuk sumber referensi secara
otomatis. (3) (Hudriati et al. 2018)

GAMBAR 56. DRAF YANG DIGUNAKAN UNTUK PRAKTIK

Selanjutnya, lakukan pengutipan dengan cara berikut:
1. Kita akan mengutip di tiga tempat seperti ditunjukkan pada Gambar
56.
2. Letakkan kursor ditempat Anda akan mengutip, mulai dari posisi “1.”
Klik Menu Zotero > Add/Edit Citation.
4. Pada saat pertama kali menambahkan sitasi, Anda akan diminta me-

w

nentukan style pengutipan terlebih dahulu.
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5. Pilih style sesuai dengan kebutuhan Anda.
6. Setelah itu akan tampil kolom pencarian referensi Zotero.

)

b Tatalloan o Anda al- lai dari nog

My Library ~

Program pengembangan kemampuan literasi anak usia dini

Basyiroh (2017), ... Program Studi Pendidikan Guru Paud Stkip ..., (Query date: 2023-10-11 ... (e
Pengembangan Literasi Anak Melalui Permainan Dadu Literasi
Hewi (2020), Thufula, (Query date: 2023-10-11 15:07:56).
Budaya Literasi Anak Melalui Cerita Rakyat Sumatera Utara Di Kampung Nelayan ...
Khairil et al. (2020), JURNAL PRODIKMAS Hasil ..., (Query date: 2023-10-11 15:07:56).
gi i lia Pada i Literasi Anak Usia Dini
Novitasari (2019), Jurnal Golden Age, (Query date: 2023-10-11 15:07:56).

GAMBAR 57. MENCARI REFERENSI YANG AKAN DISITASI

7. Carireferensiyang akan dikutip dengan menuliskan bagian judul atau
nama pengarang.

8. Pilih referensi yang akan disitasi. Anda bisa mensitasi lebih dari satu
referensi sekaligus dalam satu kutipan. Setelah itu tekan Enter.

SUSUMUMG LU SIS UL Sy U

GAMBAR 58. MEMILIH REFERENSI YANG AKAN DISITASI

9. Kutipan akan tampil sesuai dengan style dan referensi yang Anda pilih.

10. Lakukan secara berulang dengan cara yang sama untuk kutipan 2, 3
dan seterusnya.

11. Hasilnya seperti terlihat pada Gambar 59.

Dalam dunia akademik dan penelitian, manajemen referensi merupakan salah satu komponen pendu-
kung yang sangat dibutuhkan oleh peneliti untuk mengautomatisasi pengelolaan dan pengutipan refe-
rensi untuk kelancaran proses penelitian dan penulisan laporan akhir (Hewi 2020). Peneliti, mahasiswa,
dan profesional seringkali kesulitan dalam mengelola tumpukan referensi, artikel, dan dokumen yang
mereka miliki. Terkadang mereka menghabiskan banyak waktu hanya untuk mencari referensi secara
berulang, mensitasi, dan membuat daftar pustaka. (Khairil, Siregar, and Suprayetno 2020).

Padahal saat ini sudah banyak aplikasi manajemen referensi yang bisa membantu memudahkan dalam
membuat laporan penelitian, dan tugas akhir. Salah satu perangkat untuk yang paling populer dan pa-
ling banyak direkomendasikan untuk mengelola referensi adalah Zotero, yang merupakan media untuk
memfasilitasi mahasiswa dan peneliti dalam mengutip dan merujuk sumber referensi secara otomatis.
(Hudriati et al. 2018)

GAMBAR 59. DOKUMEN HASIL SITASI

Tulisan yang di-bold atau ditebalkan merupakan hasil kutipan dari
sumber referensi yang tersimpan di dalam aplikasi Zotero.
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C. MEMBUAT DAFTAR PUSTAKA OTOMATIS

Setelah semua kutipan selesai dibuat, langkah selanjutnya adalah
membuat daftar pustaka. Zotero menyediakan fasilitas untuk membuat
daftar pustaka secara otomatis, tanpa Anda perlu mengetik satu huruf

pun. Untuk membuatnya ikuti langkah berikut:

1.

Letakkan kursor di tempat Anda akan membuat daftar pustaka (di

akhir dokumen).
Pastikan Anda sudah memilih Style yang Anda inginkan.
Klik menu Add/Edit Bibliography.

Zotero A5 Desktop - Waord

Design Layout References Mailings Review View

'l:é Document Preferences
Z | [ZRefresh

MNote 9,5 Unlink Citations

GAMBAR 60. MENU PLUGIN ZOTERO

Setelahitu daftar pustaka akan tampil sesuai dengan jumlah referensi

yang Anda kutip, seperti terlihat pada Gambar 61.

Dolom dunio ckademik don penelition, monagjemen referensi merupakan selah satu komponen
pendukung yang sangot dibutuhkon aleh peneliti untuk mengautomatizosi pengeloloon don pengutipan
referensi untuk kelancaraon proses penelition dan penuwlisan laporan okhir.(Hewi 2020} Peneliti, mahasiswa,
dan prafesional seringkali kesulitan dolam mengelolo tumpukan referensi, artikel, dan dokumen yong
mereko miliki. Terkodang mereko menghabiskon banyok woktu hanya untuk mencari referensi secaora
berulang, mensitasi, don membuat daftar pustoka.(Khairil, Siregar, and Suprayetno 2020)

Padohal soat ini sudah banyok aplikosi manajemen referensi yang bisa membantu memudahkan dolom
membuat igporan penelitian, dan tugas okhir. Soloh satu perongkot untuk yang poling populer dan paling
banyak direkomendasikon wuntuk mengelola referensi adaleh Mendeley, yong merupokan media umtuk
memjfasilitasi mahasiswo dan peneliti dolam mengutip dan merujuk sumber referensi secora

otomatis. (Hudriati et al. 2018)f

DAFTAR PUSTAKA

Hewi, L. 2020. “Pengembangan Literasi Anak Melalui Permainan Dadu Literasi.” Thufila, no. Query date:
2023-10-11 15:07:56.
https:/fscholar.archive org/work/3twshmzenvbtSgaarraijdaghe/access,wayback/https:/fjournal i
ainkudus.ac.id/index.php/thufula/article/download/7238/pdf.

Hudriati, Andi, Rusdiah, Andi Anto Patak, and Muhammad Basri. 2018. “Assessing Indenesian University
Students’ Preferences on Mendeley Reference Manager for Scientific Writing.” International
Journal on Advanced Science, Engineering and Information Technofogy B8 (5): 2211-18.
https:/doi.org/10.18517/JASEIT.B.5.6671.

Khairil, K, F5 Siregar, and E Suprayetno. 2020. “Budaya Literasi Anak Melalui Cerita Rakyat Sumatera Utara
Di Kampung Melayan Seberang.” JURNAL PRODIKMAS Hasif ..., no. Query date: 2023-10-11 15:07:56.
https:/fjurnal.umsu.ac.id/index.php/prodikmas/article/view/5756.

GAMBAR 61. DOKUMEN YANG SUDAH DISITASI DAN DAFTAR PUSTAKA
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Daftar pustaka akan berubah secara otomatis setiap kali Anda me-
lakukan penambahan atau perubahan terhadap referensi yang dikutip.

D. MENGGANTI STYLE PENGUTIPAN

Setiap instansi/lembaga/perguruan tinggi mempunyai aturan dan ke-
bijakan yang berbeda dalam hal style/gaya pengutipan naskah dokumen/
laporan penelitian/tugas akhir mahasiswa. Untuk mengakomodasi hal
tersebut, Zotero menyediakan menu yang berisi sejumlah style pengu-
tipan, sesuai dengan standar pengutipan internasional. Fitur ini untuk
memudahkan pengguna dalam memilih style sesuai dengan kebutuhan
mereka. Untuk mengubahnya ikuti langkah berikut:

1, Klik Document Preferences pada menu Zotero.

Zotero - Document Preferences X

Citation Style:

American Chemical Society

American Medical Association 11th edition

American Political Science Association

American Psychological Association (APA) Tth edition
American Sociological Asseciation (ASA) 6th edition
Chicage Manual of Style 17th edition (author-date)
Chicage Manual of Style 17th edition (full note)

Ch ¥ Lok Strels 1T4h aclitiom (natal

v

Manage Styles...

Language: | English (US) st

Store Citations as:

(@) Fields (recommended)
Fields cannot be shared with LibreOffice.

The document must be saved as .doc or .doox

() Bookmarks
Bookmarks can be shared between Word and LibreOffice, but may cause emors i accidentally modified and cannot be
inserted into fectnotes.

The document must be saved 25 _doc or doox

Automatically update citations
Disabling updates can speed up citation insertien in large documents. Click Refresh te update citations manualy.

Switch to a Different Word Processor..,

GAMBAR 62. MENU DOCUMENT PREFERENCES
2. Pilih style yang Anda inginkan pada kolom Citation Style - OK.

3. Style pengutipan dan daftar pustaka otomatis akan berubah sesuai
dengan style yang dipilih.
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LATIHAN 4

1. Siapkan satu buah dokumen Microsoft Word yang minimal berisi 3 paragraf.

2. Kutip minimal 3 referensi/artikel yang tersimpan di dalam aplikasi Zotero Anda.
3. Buat daftar pustaka menggunakan style IEEE.
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MEMBUAT DAN MENGELOLA
AKUN ZOTERO

A. REGISTRASI AKUN ZOTERO

Berbeda dengan Mendeley, aplikasi sejenis yang mempunyai fungsi
dan manfaat sama dengan Zotero, yang mewajibkan pengguna mempu-
nyai akun online dan login terlebih sebelum digunakan. Aplikasi Zotero,
yang berbasis desktop, bisa langsung digunakan pada komputer/laptop
tanpa harus terkoneksi/login ke akun Zotero terlebih dahulu.

Akun online Zotero akan berguna saat Anda membutuhkan backup
terhadap daftar referensi yang tersimpan dalam aplikasi, dan pada saat
mengaksesnya menggunakan perangkat yang berbeda. Walaupun tidak
wajib sebaiknya Anda tetap membuatnya untuk berjaga-jaga agar tidak
kehilangan data pada saat terjadi kerusakan pada komputer/laptop Anda,
serta untuk memudahkan dalam mengakses referensi yang Anda miliki.

Untuk membuat akun Zotero ikuti langkah-langkah berikut:

1. Buka situs resmi Zotero pada laman: https://www.zotero.org/

0B =hn zotero.org 12 ® & QR

zotero Groups  Documentaion  Forums  Getimoved  Login

®) Your personal

research assistant

Zotero is a free, easy-to-use tool to help you
collect, organize, annotate, cite, and share research.

Download

GAMBAR 63. HALAMAN DEPAN ZOTERO
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2. Pilih“Log in” Pada bagian atas beranda Mendeley.

Groups  Documentation  Forums  Getlnvolved  Login  [USSIICTUeS

Register for a free account  Forgot your password?
Login
Username or Email

Password

[0 Remember Me

Keep me signedin

Login to Zotero

GAMBAR 64. HALAMAN LOGIN
3. Klik Register for a free account untuk melakukan registrasi akun.

andisptra

https://www.zotero.org/andisptra

da.andisaputra@gmail.com
da.andisaputra@gmail.com
ecoccece
eesccoce

Ie ]
~/ Imnotarobot

By using Zotero, you agree to its Terms of Service

GAMBAR 65. HALAMAN REGISTRASI

4. Entrikan email, username dan password yang akan digunakan untuk
akun Zotero Anda - Register.

5. lJika data yang Anda entrikan sesuai dengan ketentuan, Zotero akan
mengirimkan email konfirmasi ke email yang Anda daftarkan.

Register

Register for a free account - Log in to your account - Forgot your password?

If you haven't already created a Zotero account, please take a few moments to
register now. It's a free way to sync and access your library from anywhere, and
it lets you join groups and back up all your attached files.

Thanks for registering. We've sent an email to activate your account.

GAMBAR 66. KONFIRMASI HASIL REGISTRASI
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6. Bukaemail Anda, dan lakukan konfirmasi melalui email yang dikirim-
kan oleh Zotero dengan mengklik link yang dikirimkan.

Welcome to Zotero  rotakmasuk =
Zotero <do-not-reply@zotero.org>
kepada saya ~
Hp Inggris > Indonesia »  Terjemahkan pesan

Thanks for signing up for a zotero.org account! Please confirm
https-/iwww zatero org/userivalidate/14f06a7cbicfbded 33b0

“ Balas :] ‘ * Teruskan ‘

GAMBAR 67. EMAIL KONFIRMASI

Dengan mengklik link konfirmasi, berarti akun Zotero Anda sudah
aktif, dan bisa digunakan untuk login.

B. MENGGUNAKAN AKUN ZOTERO

Untuk menggunakan akun Zotero, Anda bisa langsung membuka
laman web resminya https://www.zotero.org/ setelah itu ikuti langkah
berikut:

1. Klik menu Sign in. setelah itu Anda diminta mengentrikan username
dan password - klik Login to Zotero.

08 =o zoternorg/userfoci o g LM A@H =

GAMBAR 68. MENU LOGIN ZOTERO

2. Setelah berhasil login klik Web Library untuk menuju ke halaman ko-
leksi yang Anda miliki.
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3. Atau bisa juga menuju ke akun Zotero dengan mengklik nama peng-
guna Anda pada sudut kanan atas.

< @ 202312340032:P1 X ™ allintitle "Literat X Z Zotero | Passwor X £ (1) Whatsapp » S hEd

I d e
Web Library Yroups Documentation Forums  Get invo\ve
My Profile

Inbax

Settings

Your personal i

GAMBAR 69. ANTAR MUKA ZOTERO ONLINE

4. Klik My Profile, setelah itu akun Anda akan terbuka.

Welcome, andisaputra « Settings - Inbox - Download - Log Out

ZOLEro

IHnma Web Library  Groups Documentation Forums Get Involved

Home > Pecpls > andisaputra

Invite andicaputra to join one of your

andisaputra Aoums

:t Profile Groups

GAMBAR 70. HALAMAN AKUN ZOTERO

5. Klik Library, pada menu ini Anda bisa melihat seluruh daftar referensi
yang dimiliki, seperti terlihat pada Gambar 71.
zotero Web Library Groups Documentation

Tile Creator

SINTA - Science and Technology Index

Nurachman et al

&1-Daihani and Abrzhams

=) Effect of duration of sonication during gelatinzation on properties of tapioc...  Asrofist al
F Perbedaan Artikel Risst dan Arfikel Review rahmadys
= Unand Peringkat 12 Untuk Kategor PTN di Scapus saputs

= 5o

ment Skills and s Jan and Anwar

Optimizetion of bulk modified atr, ckaging for lang-term storsg Lizmminr 2t 2

GAMBAR 71. MENU WEB LIBRARY
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Pada akun Anda tentu saja daftar referensinya masih kosong. Akun
Anda akan berisi daftar referensijika sudah disinkronisasi dengan aplikasi
Zotero yang ada pada komputer/laptop Anda. Proses sinkronisasi akan
menyalin data referensi yang tersimpan di dalam aplikasi Zotero ke dalam
akun Zotero online (baca sub bab Sinkronisasi pada bab Setting Aplikasi).

C. UPGRADE AKUN ZOTERO

Pengguna Zotero tidak dibebankan biaya untuk mendapatkan akun
online alias gratis. Cuma sayangnya kapasitas penyimpanannya tidak
begitu besar. Zotero hanya memberikan kuota ruang penyimpanan gratis
sebesar 300 MB. Bagi pengguna personal, sebenarnya kuota sebesar itu
cukup memadai, karena Zotero berbasis desktop, sehingga tidak menja-
dikan akun online sebagai tempat penyimpanan utama. Akun online hanya
berguna sebaga backup data, dan untuk melakukan sinkronisasi data agar
bisa digunakan dan diakses menggunakan perangkat yang berbeda.

Bagi pengguna yang membutuhkan kapasitas penyimpanan sangat
besar, akunnya bisa di-upgrade dengan beberapa skema pembayaran
sesuai dengan ukuran/kapasitas penyimpanan yang dibutuhkan. Untuk
melakukannya ikuti langkah berikut:

1. Buka laman web Zotero, dan Sign in ke dalam akun Anda.
2. Setting akun Anda dengan mengklik Upgrade Storage pada sudut
kanan atas layar Zotero Anda.

andisaputra ¥ Q- Upgrade Storage

GAMBAR 72. TOMBOL UPGRADE STORAGE

3. Selanjutnya akan dibawa ke halaman Zotero Storage, seperti terlihat
pada Gambar 72.
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lHome Web Library  Groups Documentation Forums  Get Involved

Home > Settings > Storage

Zotero Storage
Account - Profile © G.V. - Privacy - Email + Feeds/API - Storage
Frequently Asked Questions

No currently active clisnts that have synced.

Current Plan Change Plan

Quota 300 MB Storage Amount  Annual Price (USD)

Expiration Never 300 MB Free

Current Usage My Library - 294.5 MB 2GB $20
Total - 294.5 MB. s GE 560

N Unlimited $120 SelogifiEe

98.2%
GAMBAR 73. HALAMAN SUBSCRIPTION

4, Zotero menyediakan 3 pilihan kepada Anda untuk meng-upgrade ka-
pasitas penyimpanan data, yaitu: 2 GB, 6 GB, dan Unlimited, dengan
biaya yang bervariasi pula tentunya (“Zotero | Storage” 2023), seperti
terlihat pada Gambar 72.

Selanjutnya pilihan ada pada Anda, walaupun dengan versi gratis
Anda masih tetap menyimpan data referensi sebanyak apa pun di dalam
komputer/laptop Anda. Sedangkan akun online hanya bisa mem-backup
datareferensi yang Anda miliki sebatas ukuran gratis yang diberikan (300
MB).



I Bab 7

MEN-SETTING APLIKASI
ZOTERO

A. MENGATUR TAMPILAN ANTARMUKA ZOTERO

Antarmuka Zotero bisa diatur sesuai dengan kebutuhan pengguna
pada menu View. Ada beberapa pilihan yang tersedia untuk mengatur
tampilan pada menu ini, seperti terlihat pada Gambar 74.

z Kernas Ulang Informasi - Zoterc
File Edit View Tools Help

g @ Layout > | Ao
v @ My Font Size b
ik Mote Font Size * literature
=l b Show Items from Subcollections
| Li reressreresr T Availab
| Preservasi Digital Terzannka

GAMBAR 74. MENU VIEW

1. Mengatur Tampilan Panel Antarmuka

Sub menu ini digunakan untuk mengatur tampilan panel/bilah antar-
muka Zotero, seperti menampilkan/menyembunyikan collection pane/my
library, dan item pane/panel informasi. Untuk mengatur tampilan panel
antarmuka, ikuti langkah berikut:

a. Klik menu View > Layout.
b. Pastikan Standar View, Collections Pane, dan Item Pane aktif/tercen-
tang.
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2. Mengatur Ukuran Font Antarmuka

Ukuran font yang ada pada antarmuka Zotero bisa drubah sesuai de-
ngan kebutuhan. Sayangnya, Zotero hanya menyediakan dua pilihan yaitu:
Bigger dan Smaller. Untuk mengaturnya bisa melalui:

| menu View - Font Size - pilih ukuran sesuai kebutuhan

3. Mengatur Ukuran Font Anotasi

Selain ukuran font antarmuka, pengguna Zotero juga dimungkinkan
mengganti ukuran font Anotasi. Berbeda dengan font antarmuka, pada sub
menu ini Zotero justru menyediakan ukuran font yang lebih bervariasi, dari
yang terkecil sampai yang paling besar.

Untuk mengaturnya pengguna bisa menuju ke:

| Menu View > Note Font Size -> pilih ukuran sesuai kebutuhan |

4. Mengatur Lokasi Penyimpanan Data

Secara default Zotero sudah menetapkan lokasi penyimpanan data/
daftar referensi yang dimiliki oleh pengguna, tepatnya di C://Users/regis/
Zotero. Selain itu pengguna juga diberi kebebasan untuk menentukan
lokasi penyimpanan data sendiri. Untuk mengganti lokasi penyimpanan
Zotero ikuti langkah berikut:

a. Klik Menu Edit - Preferences, setelah itu akan tampil menu Zotero

Preferences seperti pada Gambar 75.

€ @H 0O & &

General  Syne Search  Export Cite  Advanced

General Files and Folders Shortcuts Feeds
Miscellaneous
[ Automatically check for updated translators and styles | Update now
Report broken site translators

Languzge: | Automatic (English)

GAMBAR 75. MENU ZOTERO PREFERENCES
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b. Klik sub menu Files and Folders - lihat kolom Data Directory/Loca-
tion. Disini terlihat lokasi penyimpanan data Zotero secara default.

General  Sync Search  Export Cite | Advanced

General Filesand Folders Shortcuts Feeds

Linked Attachment Base Directory

Zotero will use relative paths for linked file attachments within the base directory, allowing you to

access files on different computers as lang as the file structure within the base directory remains the
same.

Base directory: Choose..

Revert to Absolute Paths...

Data Directory Lacation
@ Default (CAUsers\regis\Zotero)

O Custom: Choose...

Show Data Directory

Database Maintenance

Check Database Integrity | | Reset Translators.. | Reset Styles..

GAMBAR 76. MENGATUR FOLDER PENYIMPANAN

c. Untuk mengganti lokasi penyimpanan klik Custom - Choose.

2 Select a Zotero data directory X
A [+ Ahmad Sysiqu s Zotero v o Search Zotero
Organize v New folder =~ @
* Name Date modified Type
# Quick access
locate File folder
@ OneDrive - Persor logs File folder
8 This pe storage File folder
styles File folder
J 30 Objects
translators File folder
I Deskiop
% Documents
& Downloads
J Music
&) Pictures
B videos
i, Windows (C)
— Data (D)) ¥ 5
Folder: |

Select Folder Cancel

GAMBAR 77. MEMILIH FOLDER PENYIMPANAN ZOTERO

d. Tentukan lokasi penyimpan baru, sebaiknya data Anda disimpan di
drive D, untuk mengantisipasi terjadi kerusakan pada komputer Anda.

e. Buat folder khusus, supaya data tidak tercampur dengan data lain.

f. Setelah itu klik Select Folder > Quit Zotero untuk mengakhirinya.
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Setelah Anda mengganti lokasi penyimpanan, maka aplikasi Zotero
otomatis akan tertutup. Selanjutnya pada saat aplikasi dibuka kembali
daftar referensi Anda akan kosong, karena Zotero membaca data di lokasi
yang baru. Adapun data sebelumnya tetap tersimpan pada lokasi pe-
nyimpanan yang baru. Untuk bisa mengaksesnya, Anda harus mengubah
kembali lokasi penyimpanan ke lokasi semula (default).

Selain itu untuk menyalin data sebelumnya, Anda bisa menyinkronkan
aplikasi Zotero dengan akun online Anda yang tersimpan di dalam databa-
se Zotero (jika Anda sudah memilikinya) menggunakan fitur Sync.

B. PENGATURAN UMUM/GENERAL SYSTEM

Pada sub bab ini kita akan mengatur tentang bagaimana penanganan
berkas yang diimpor, dan disimpan dalam aplikasi Zotero pada menu Ge-
neral Setting. Untuk mengaturnya ikuti langkah berikut:

1. Klik menu Edit > Preferences, setelah itu akan tampil halaman Gene-

ral Setting, seperti terlihat pada Gambar 78.

Zotero Preferences x
5 3 = = Iy
e @ (6 &= &
General Sync Search Export Cite Advanced

File Handling
A [ Automatically take snapshots when creating items from web pages
[ Automatically attach associated PDFs and other files when saving items
C [ Automatically retrieve metadata for PDFs
A tutomatically rename attachment files using parent metadata
[ Rename linked files

€ Open PDFs using  Zotero v

Miscellaneous
[ Automatically tag items with keywords and subject headings
 Automatically remove items in the trash deleted more than days ago
PDF Reader
T showtabs as [Title- Creator - Year ~
Groups
When copying items between libraries, include:
child notes
child snapshots and imported files
[ annetations
child links
[Atags

GAMBAR 78. MENU PENGATURAN UMUM

2. Padahalaman tersebut terdapat beberapa kolom yang dapat kita atur
sesuai dengan kebutuhan. Pada dasarnya Zotero sudah mengaturnya
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secara default. Tetapi untuk lebih mudah memahami fungsinya, perlu
kita ketahui fungsi dari masing-masing kolom jika diaktifkan/dicen-

tang.

a. Zotero secara otomatis akan mengambil/menyimpan halaman
website sebagai snapshot.

b. Zotero secaraotomatis akan menyimpan file PDF dan file lainnya
yang menyertai sebuah item yang diimpor melalui impor manual
ataupun Zotero Connector.

c. Zotero secara otomatis akan mengambil dan menyimpan meta-
data yang menyertai dokumen PDF yang diimpor.

d. Lampiran sebuah item secara otomatis akan diganti namanya
sesuai dengan metadata item yang diimpor.

e. Digunakan untuk memilih metode untuk membuka file PDF, apa-
kah terbuka langsung di aplikasi, atau dibuka menggunakan
aplikasi lain.

f. Zotero secara otomatis akan memberikan tag pada sebuah item
menggunakan kata kunci yang terdeteksi.

g. Menentukan berapa lama sebuah item yang sudah dihapus ter-
simpan di dalam Trash (tempat penyimpanan sementara) sebelum
otomatis dihapus secara permanen oleh Zotero.

h. Digunakan untuk menentukan kolom-kolom yang ditampilkan
pada halaman daftar referensi.

SINKRONISASI

Sinkronisasi merupakan fitur yang disediakan oleh Zotero untuk
menyelaraskan antara daftar referensi yang tersimpan pada aplikasi
dengan akun Zotero online Anda. Sinkronisasi penting dilakukan untuk
mem-backup data yang Anda miliki agar tidak hilang pada saat komputer
Anda mengalami kerusakan. Selain itu dengan melakukan sinkronisasi,
Anda bisa mengakses daftar referensi yang Anda miliki kapan saja, dan
dari mana saja, serta menggunakan perangkat yang berbeda.

Manfaat Sinkronisasi

Berikut dijelaskan beberapa fungsi sinkronisasi Zotero:
Backup Data
Sinkronisasi berfungsi untuk membuat cadangan data. Setiap peru-
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bahan dan penambahan yang Anda lakukan pada Zotero, secara oto-
matis akan tersimpan pada akun Zotero, dan begitu juga sebaliknya.
Memudahkan Mengakses Data

Sinkronisasi memungkinkan Anda menggunakan Zotero di berbagai
perangkat, Anda dapat mengakses seluruh referensi, catatan, dan
pengaturan menggunakan berbagai perangkat, seperti komputer
desktop, laptop, dan perangkat seluler, serta bisa mengaksesnya
kapanpun dan di mana pun Anda berada.

Pengelolaan Referensi yang Efisien: Saat Anda menambahkan, meng-
edit, atau menghapus referensi di salah satu perangkat, perubahan
tersebut akan direplikasi ke semua perangkat yang terhubung melalui
sinkronisasi. Ini menjaga koleksi referensi Anda tetap konsisten dan
terorganisasi.

Memudahkan Kolaborasi

Sinkronisasi memungkinkan setiap anggota yang tergabung dalam
satu grup berkolaborasi dalam proyek penelitian secara efisien. Seti-
ap di-update data oleh satu anggota secara otomatis akan tersinkro-
nisasi dengan anggota lainnya, sehingga semua data dan informasi
yang diakses oleh anggota selalu sama.

Cara Melakukan Sinkronisasi

Untuk melakukan sinkronisasi antara aplikasi Zotero dengan akun

Zotero online ikuti langkah berikut:

a.

b.
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Klik menu Edit - Preference > Sync atau klik ikon Sync with Zotero.
org @ .
Selanjutnya Anda akan dibawa ke halaman Zotero Preferences

ZLotero Preterences A

S @ O & X

General Sync Search Export Cite  Advanced

Seftings Reset

Data Syncing

Username: Create Account

About Syncing
Set Up Syncing

GAMBAR 79. MENU SINKRONISASI

-~ ~
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c. Masukkan Username & Password - Klik Set Up Syncing

d. Kalau akun yang Anda masukkan benar, maka aplikasi Zotero Anda
langsung terhubung dengan akun Zotero online, ditandai dengan tam-
pilnya tombol Unlink Account di samping Username.

e. Untuk memutuskan hubungan dengan akun online, cukup klik tombol
Unlink Account tersebut.

f.  Klik OK untuk menutup halaman Zotero Preferences.

Zotero Preferences X
() E QP
3 2 & ” s
General Sync Search Export Cite  Advanced

Settings Reset

Data Syncing

Username: andisaputra | Unlink Account...
Choose Libraries.

Sync automatically
Syne full-text content
About Syncing
File Syncing
[ Sync attachment files in My Library using | Zotero

Download files | as needed v

Sync attachment files in group libraries using Zotero storage

Download files | asneeded v

By using Zotero storage, you agree to become bound by its terms and conditions.

Cancel Help
GAMBAR 80. MENU SETTING SINKRONISASI

g, Setelahakunterhubung,jika ingin melakukan sinkronisasi, Anda ting-
gal mengklik tombol Sync pada sudut kanan atas halaman Zotero.

GAMBAR 81. IKON SINKRONISASI

h. Hasilnya seperti terlihat pada Gambar 81.
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2 Wy Library - Zotero
Eile Edit View JIools Help

s @~ ©- A B~ F-|
~ [ My Library Title
COBIT =% Cara-Penggunaan- Turnitin-Metodologi-Penelitian. pdf
Data Mining = Cara Membaca Momor Induk Kependudukan (NIK)

Digitalisasi
Jaringan Kerjasam Perpus

Black-Tea-with-Averrhoa-Bilimbi-L-Extract-A-Healthy-Beverage_2016_Agriculture-an...
bibliometrics-as-a-research-field-Bib_Module_KUL.pdf
Kemas Ulang Informasi Beberapa datasets yang bisa anda gunakan untuk riset dan development aplikasi - La...

Kemas Ulang Informasi barnes2003.pdf

Kesehatan Mental Anak Remaja =2 Avoiding-Gender-D -heorian- Women-b Political-Challenges-and-E..
LITERASI ANAK =¥ Avociding-Gender-Det -Ivorian-Wom clitical-Challenges-and-E...
Open Access =2 article.pdf
Preservasi Digital =2 article.pdf
Prestasi Akademik =2 article.pdf
Repackaging Information =2 article.pdf
Social Media =2 article.pdf
Standar Nasional Perpustakaan =2 article.pdf

Article Details
Arif-Surachman-Makalah-KPDI4-2011-Prosiding.pdf

Stock Opname
Tate Kelola Lokal Konten

14D

Turnitin Are-we-Close-to-Achieve-Real-Equality-under-Current-Policies-A-View-from-the-Pe...

Waste Management =% Are-we-Close-to-Achieve-Real-Equality-under-Current-Policies-A-View-from-the-Pe...
Webqual =* Appendix B - blended-learning.pdf
Weka “* Antihypertensive-and-antioxidant-activity-of-Cassytha-filiformis-L-A- correlative-stu...

GAMBAR 82. HASIL SINKRONISASI

Daftar referensi yang sebelumnya hanya sedikit, sekarang sudah
bertambah dengan data yang tersimpan di dalam akun online. Pada saat
mengklik tombol Sync, seluruh data yang tersimpan di dalam akun Zotero
online akan disalin ke dalam Zotero Desktop.

Begitu juga sebaliknya, daftar referensi yang ada di dalam akun Zote-
ro online yang Anda miliki juga disinkronkan/disesuaikan dengan dengan
daftar referensi yang ada di dalam aplikasi Zotero Desktop, atau setiap kali
dilakukan pembaruan/penambahan item. Sehigga setiap kali dilakukan
proses sinkronisasi, jumlah daftar referensi yang ada di dalam aplikasi
akan sama dengan yang tersimpan di dalam akun online.

Jika koneksi tidak terputus, Zotero akan melakukan proses sinkroni-
sasi secara berkala, atau setiap kali Anda membuka aplikasi. Prosesnya
akan berhenti jika Anda memutuskan koneksi, dengan mengklik tombol
Unlink Account pada menu Zotero Preferences.

D. MEMBUAT NEW FEED PADA ZOTERO

New Feed merupakan salah satu fitur pada sebuah web yang me-
nyediakan cara mudah untuk mengakses dan memantau pembaruan
konten dari sebuah situs web atau sumber yang Anda minati. Zotero
menyediakan New Feed untuk berlangganan penelitian/terbitan terba-
ru dari jurnal, situs web, penerbit, institusi, kelompok penelitian, atau
sumber lain sehingga Anda bisa menemukan artikel atau karya terbaru
dengan cepat.
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1. Fungsi Feeder/New Feed

Berikut dijelaskan beberapa fungsi Feeder yang ada pada sebuah web:

a. Berlangganan Konten
Jika pengguna berlangganan/memasang Feeder sebuah situs atau
blog yang mereka minati, secara otomatis mereka akan menerima
pembaruan pada saat konten baru dipublikasikan oleh situs yang
dilanggan.

b. Pembaruan Konten Secara Real-Time
Feeder akan memberi tahu pengguna tentang pembaruan konten
terbaru yang ada pada situs web atau blog tanpa harus mengunjungi
situs tersebut.

c. Agregasi Konten
Feeder memungkinkan terjadinya proses agregasi konten dari ber-
bagai sumber ke satu tempat. Pengguna dapat mengumpulkan dan
mengelola setiap pembaruan yang diunggah pada beberapa situs web
yang dilanggan dalam satu feed reader.

d. Efisiensi Waktu
Dengan menggunakan Feeder, Anda bisa menghemat waktu karena
Anda tidak perlu mengunjungi setiap situs web yang diikuti untuk
melihat pembaruan informasi.

Dengan berbagai manfaat yang ditawarkan, ada baiknya Anda me-
masang Feeder untuk berlangganan informasi terkait dengan pembaruan
referensi dari sumber-sumber yang Anda minati.

2. Cara Memasang New Feed

Sebelum memasang New Feed pada aplikasi Zotero, kita harus me-
nentukan terlebih dahulu sumber referensi yang akan dilanggan, dan
mencarilink URL situsnya. Selain itu situs yang akan dilanggan harus me-
nyediakan RSS Feed pada halaman website-nya, agar kita bisa mengcopy
alamat/link-nya, untuk dipasangkan pada aplikasi Zotero.

Dalam hal ini kita akan mencoba menambahkan New Feed pada
aplikasi Zotero untuk berlangganan informasi dari repositori Universitas
Andalas. Untuk memasangnya ikuti langkah berikut:

a. Buka situs yang akan dilanggan: https://scholar.unand.ac.id/.
b. Cari menu RSS Feed yang ada pada situs yang akan dilanggan.
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RS5FEEDS

B RSS1.0
) RSS20

] Atom

GAMBAR 83. MENU RSS FEEDS

c. Pilih RSS 2.0, klik kanan = copy link
d. Buka aplikasi Zotero.
e. Klik ikon New Library g~ > New Feed - From URL.

Feed Settings X

URL: | http://scholar.unand.ac.id/cgi/latest_tool?output= RSSZ] |

Title: | eSkripsi Universitas Andalas: Mo conditions. Results ordered -Date [|

~ Advanced Options

Update feed every houris)
Remove read feed items after dayf(s)
Remove unread feed items after day(s)

GAMBAR 84. MENU FEED SETTINGS

f. Entrikan/paste link RSS Feeds yang sudah di-copy pada kolom URL.
g. Buat judul Feed pada kolom title (biasanya otomatis akan terisi pada
saat Anda mem-paste link URL).
h. Klik Advanced Options untuk mengatur New Feed
1) Update feed every: untuk mengatur waktu pembaruan informasi,
jika Anda memilih 1 hour, maka setiap satu jam Anda akan mene-
rima pembaruan informasi pada situs yang dilanggan.
2) Remove read feed items after: untuk mengatur waktu pengha-
pusan secara otomatis item yang sudah dibaca.
3) Remove unread feed items after: untuk mengatur waktu pengha-
pusan secara otomatis item yang belum dibaca.
Waktunya bisa disesuaikan dengan kebutuhan Anda, atau tingkat
pembaruan informasi pada situs yang dilanggan.
i. Klik Save untuk menyimpan, hasilnya seperti terlihat pada Gambar 85.
Seluruh New Feed yang Anda buat akan, disajikan di kolom My Library,
di bawah daftar folder yang Anda miliki.



[Eal Feeds
.| eSkripsi Universitas Andalas: No...

BAB 7 + MEN-SETTING APLIKASI ZOTERO

Tingkat Pengetah Y Tentang Kejadian lkuta...
PENGARUH LAMA FERMENTAS| DARI CAMPURAN KULIT FISANG B...

PENGARUH DOSIS INOKULUM WARETHA (Bacillus amyloliquefacien...

SIFAT KUALITATIF KERBAU LUMPUR (BUBALUS BUBALIS) DI KECA...

Faktor yang Berhubungan dengan Kejadian HIV/AIDS pada Wanita U...

DAMPAK ALOKASI DANA OTONOMI KHUSUS TERHADAF PEMBAN...
ANALISIS PENERAPAN AKUNTANSI ZAKAT PADA BANK UMUM SYA...
Aplikasi Artificial Neural Network Untuk Menentukan Kandungan §...
MOBILISASI OLEH ELIT TRADISIONAL PADA PEMILIHAN KEPALA DA...
PENGARUH INVESTASI, KONSUMSI RUMAH TANGGA DAN PENGEL...

Tingkat penyakit hawar daun (Helminthosporium sp.) pada ...
ANALISIS FAKTOR-FAKTOR YANG MEMPENGARUHI KESEJAHTERAA...

ANALISIS USAHATANI SAYURAN PAKCOY HIDROPONIK PADA ARIF ...

GAMBAR 85. TAMPILAN NEW FEED

Setiap terjadi penambahan/pembaruan data pada situs yang dilang-
gan, akan masuk ke dalam New Feed Anda. Seandainya ada referensi yang
ada pada New Feed yang diminati, Anda tinggal memindahkan/meng-copy-
nya ke dalam folder yang Anda miliki.

3. Berhenti Berlangganan

Suatu saat jika tidak dibutuhkan lagi, Anda bisa berhenti berlanggan-
an New Feed. Untuk menghentikannya ikuti langkah berikut:

a. Klik kanan judul Feeder.

| Zotefo

My Publications

77 Duplicate tems

Unfiled lterns “%  Refresh Feed

ol Trash

(Bl Feeds

Mark Feed as Read
[ Edit Feed..

- eSkripsi Unive ‘il Unsubscribe from Feed...

GAMBAR 86. MENU KLIK KANAN FEEDS

b. Pilih Unsubscribe from Feed, untuk berhenti berlangganan.
. Selanjutnya akan tampil menu konfirmasi, pilih Unsubscribe.
d. Setelah itu feeder tersebut akan hilang dari aplikasi Anda.

LATIHAN 5

Anda.

1. Lakukan registrasi untuk membuat akun Zotero online Anda.
2. Lakukan sinkronisasi referensi yang ada di dalam aplikasi dengan akun Zotero

3. Langgan informasi repository IPB (https://repository.ipb.ac.id/), dengan mem-
buat New Feed pada aplikasi Zotero Anda.







EEN BAB 8

MENGGUNAKAN ZOTERO DI
GOOGLE DOCS

oogle Docs, merupakan salah satu alternatif bagi pengguna Zotero

pada saat aplikasi pengolah kata yang digunakan tidak kompatibel

dengan Zotero. Salah satu yang sering tidak kompatibel dengan
Zotero adalah WPS Office. Zotero bisa membantu Anda dalam menam-
bahkan kutipan dan bibliografi ke dokumen yang Anda buat di Google
Docs dengan mudah, selayaknya mensitasi menggunakan Word dan Lib-
reOffice. Seluruh fitur Add-ons Zotero yang dimiliki aplikasi pengolah kata
tersebut juga tersedia pada menu Google Docs.

Dukungan Zotero pada Google Docs merupakan bagian dari fitur
Zotero Connector yang diinstal pada browser, seperti Chrome, Firefox,
Edge, dan Safari. Sebelum menggunakan Zotero di Google Docs, pastikan
browser yang Anda gunakan sudah terinstal Zotero Connector (baca sub
menu Zotero Connector pada BAB 2). Pada saat melakukan instalasi seca-
ra otomatis, menu Zotero akan ditambahkan ke antarmuka Google Docs
Anda. Hasilnya seperti terlihat pada Gambar 87.

@
Tools Extensions Zotero Help

Normal text ~ Add/edit citation... Ciri+Alt+C Yy A 2 | e (- 2

1 2 Add note.
Add/edit bibliography
Document preferences...
Refresh
B Meeting Switch word processors...
Unlink citations...

GAMBAR 87. MENU ZOTERO DI GOOGLE DOCS
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A. KEGUNAAN FITUR-FITUR ZOTERO

Berikut dijelaskan kegunaan dari beberapa opsi yang ada di dalam
menu Zotero di Google Docs

OPSI KETERANGAN

Add/Edit Citation Menambahkan kutipan baru atau mengedit kutipan yang sudah ada
di dokumen sesuai dengan lokasi kursor.

Add/Edit Membuat daftar pustaka/menyisipkan bibliografi di lokasi kursor
Bibliography atau mengedit bibliografi yang sudah ada.
Preferences Membuka jendela Preferensi Dokumen untuk mengubah gaya

kutipan, bahasa, dan lainnya.

Refresh Segarkan semua kutipan dan bibliografi, perbarui metadata item apa
pun yang telah berubah di Library Zotero Anda.

Unlink Citations Membatalkan tautan kutipan Zotero yang ada di dalam dokumen
dengan menghapus field codes untuk mencegah pembaruan
otomatis lebih lanjut dari kutipan dan bibliografi.

Perlu diperhatikan bahwa penghapusan menghapus field codes tidak
bisa dibatalkan, oleh karena itu hanya boleh dilakukan di dalam
salinan dokumen, bukan pada dokumen asli.

B. SYARAT PENGGUNAAN DAN AUTENTIKASI ZOTERO DI
GOOGLE DOCS

Ada beberapa persyaratan yang harus dipenuhi terlebih dahulu, sebe-

lum Anda mensitasimenggunakan Zotero di Google Docs, yaitu.

1. Pastikan Anda sudah menginstal aplikasi Zotero Desktop di komputer/
laptop Anda

2. Pastikan pada browser yang Anda gunakan sudah terinstal Zotero
Connector, ditandai dengan tampilnya icon Save to Zotero di sudut
kanan atas menu browser yang Anda gunakan.

Pada saat pertama kali menggunakan fitur Zotero pada dokumen di
Google Docs, Anda diminta untuk melakukan autentikasi plugin dengan
akun Google Anda. Pastikan akun yang Anda gunakan untuk membuat
dokumen sudah diberi akses untuk mengedit dokumen tersebut.

Setelah autentikasi selesai dilakukan, Anda dapat mulai menam-
bahkan kutipan ke dalam dokumen dari Zotero Library yang ada di dalam
aplikasi Zotero Desktop Anda.
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C. MENSITASI MENGGUNAKAN GOOGLE DOCS

Mengutip/mensitasi referensi menggunakan Zotero di Google Docs

caranya sama dengan pada saat kita menggunakan Word. Untuk memu-
lainya ikuti langkah berikut:

1.

2.
3.

4.

5.
6.
7.

Pastikan aplikasi Zotero Anda sudah aktif/terbuka.

Klik menu Zotero a Add/Edit Citation.

Pada saat pertama kali mengutip Anda diminta memilih style yang
akan digunakan terlebih dahulu. Setelah itu kita bisa langsung men-
cari/memilih referensi yang akan disitasi.

“Terkadang menunya tidak langsung muncul di layar. Untuk melihatnya klik/
buka ikon Zotero yang ada di Taskbar (bagian bawah monitor).”

Google Sites Made Easy: Websit.. [l Quick Format Citation

GAMBAR 88. IKON ZOTERO DI TASKBAR MENU

Selanjutnya cari referensi yang Anda butuhkan, dengan mengentrikan
bagian judul atau nama pengarang pada bilah pencarian (kotak dialog)
Zotero.

My Library fal
Cultural and socioeconomic differences in academic motivation and achievement...

Young et al. (2011), Journal of border educational research, 9(1).

The rise of urban Salafism in Indonesia: The social-media and pop culture of new ...
Aidulsyah (2023), Asian Journal of Sedial Science.

Social mediatization of religion: islamic videos on YouTube
Al-Zaman (2022), Heliyon, 8(3), e09083.

Utilization of YouTube as an information resource to support university courses
Almobarraz (2018), The Electronic Library, 36(1), 71-81.

GAMBAR 89. KOTAK DIALOG ZOTERO
Item yang sesuai akan langsung muncul di bawah kotak dialog.

Silahkan pilih/klik item yang akan Anda kutip.
Tambahkan refrensi berikutnya, jika dibutuhkan.

13
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8. Kalau sudah selesai tekan Enter untuk menyisipkan kutipan dan me-
nutup kotak dialog.

9. Lakukan secaraberulang sampai seluruh kutipan sudah ditambahkan
ke dalam dokumen Anda.

D. BIBLIOGRAFI

Fungsi bibliografi digunakan untuk membuat dan mengganti/meng-
edit daftar pustaka, berdasarkan kutipan yang sudah dibuat. Berikut
dijelaskan bagaimana cara membuat bibliografi menggunakan Zotero di
Google Docs.

1. Membuat Daftar Pustaka (Bibliografi)

Setelah semua referensi ditambahkan, selanjutnya Anda perlu mem-
buat daftar pustaka. Dalam hal ini Zotero menyediakan fitur otomatis,
yang bisa dilakukan dengan mengklik menu Zotero a Add/edit Biblio-

graphy.

2. Mengganti Daftar Pustaka

Sama halnya dengan aplikasi pengolah kata lainnya, Zotero juga
menyediakan fitur untuk mengubah style daftar pustaka. Anda tinggal
mengklik menu Zotero a Document Properties, setelah itu silahkan dipilih
style yang akan digunakan.

Language: | English (US) ~

[ Automatically update citations
Dissbing upds peed up citston inserfon in Cick Refresh to updte ctstions manusly

Switch to a Different Word Processor...

GAMBAR 90. DOCUMENT PROPERTIES

Pada menu ini, Anda juga bisa mengubah bahasa yang akan diguna-
kan untuk memformat kutipan dan daftar pustaka, melalui kolom Langua-
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ge. Untuk mempelajari lebih lanjut, atau style yang Anda butuhkan tidak
terdaftar dalam daftar, Anda bisa menambahkan dan mempelajari lebih
lanjut dengan mengklik menu Manage Style yang ada di sebelah kanan
bawah daftar.

E. KOLABORASI

Google Docs memungkinkan pengguna untuk berkolaborasi dalam
mengerjakan sebuah dokumen secara bersama-sama. Anda dan rekan
penulis lainnya, yang diberi hak akses, dapat menyisipkan dan mengedit
kutipan ke dalam dokumen yang sama. Sebelum melakukan perubah-
an pengutipan terhadap sebuah dokumen sebaiknya setiap pengguna
memastikan telah menginstal Zotero Connector pada browser yang di-
gunakan terlebih dahulu. Jika seseorang menambahkan sebuah kutipan
aktif tanpa menggunakan Zotero Connector, maka kutipan tersebut akan
dibatalkan tautannya dari Zotero, dan terhapus dari daftar pustaka. Pada
saat orang lain mengakses/mengedit dokumen tersebut menggunakan
Zotero Connector, akan muncul peringatan tentang adanya kutipan yang
tidak terkoneksi. Selain itu, pada saat bekerja secara kolaboratif pada
sebuah dokumen, Anda dan rekan lain harus menghindari menyisipkan
atau mengedit kutipan secara bersamaan (Dstillman, 2023).

F. MENYIMPAN DOKUMEN UNTUK PUBLIKASI

Pada saat dokumen Anda selesai dibuat, dan siap dikirim untuk di-
publikasikan, pastikan Anda membuat salinannya terlebih dahulu. Hal ini
bertujuan agar kutipan dan daftar pustaka dokumen yang akan dikirim
tidak berubah saat digunakan di tempat lain. Untuk itu, langkah yang perlu
dilakukan adalah:

1. Buat salinan dokumen, dengan mengklik menu File & Make a Copy a
Buat nama file baru a Make Copy.

2. Pada dokumen baru/hasil salinan gunakan Unlink Citation untuk
mengkonversi kutipan dan bibliografi menjadi teks biasa, dengan
mengklik Zotero — Unlink Citations.

3. Setelahitu Andadapat mengunduh dokumen salinan tersebut (misal-
nya, dijadikan PDF).

4. Sedangkan dokumen asli disimpan sebagaimana adanya, untuk ber-
jaga-jaga jika diperlukan revisi/perubahan.
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TROUBLESHOOTING

A. MENAMPILKAN ADD-ONS MICROSOFT WORD

Add-ons atau menu Zotero pada Microsoft Word merupakan salah
satu fitur wajib yang harus dimiliki oleh pengguna Zotero. Fitur ini digu-
nakan untuk mensitasireferensi yang tersimpan pada aplikasi. Pada saat
menginstal Zotero, Add-ons secara otomatis akan terpasang sebagai salah
satu menu utama pada aplikasi Microsoft Word Anda. Tapi pada beberapa
kasus terkadang Add-ons tidak terinstal dengan baik. Jika hal itu terjadi
maka Anda harus menginstalnya secara manual. Ada perbedaan cara
mangatasi masalah Add-ons pada Microsoft Word versi terbaru (2019 dan
yang terbaru), dan versi lama (sebelum 2019). Berikut dijelaskan perbe-
daannya.

1, Menampilkan Add-ons pada Microsoft Word Versi Lama

Untuk menampilkan menu Zotero pada Microsoft Word lama ikuti
langkah berikut:
a. Carifile Zotero Macro yang tersimpan di dalam folder instalasi Zotero.
b. Buka Windows Explorer Anda, buka drive C:\Program Files\zotero\
zoteroWinWordIntegration@zotero.org\install.

& = v A [l> ThisPC » Windows(C) > Users > hp > > zoter dintegratior rg > install

O Name Date modified Type Size
v # Quick access

[H Desktop
& Downloads

] Documents

Microsoft Word §... 53KB

Microsoft Word M... 45 KB

B % %%

=] Pictures

etc

GAMBAR 91. FILE ZOTERO MACRO

c. Copy file Zotero macro, seperti yang ditunjukkan pada Gambar 88.
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d. Buka aplikasi Microsoft Word Anda.

e. Klik menu File > Options > Advanced - File locations - Startup >
Modify.

‘ Optio File Locations

General [ Cepy remetely 88 iz Tocations |
| Allow backgroun
Display
1| Precing Preserve fidelity whd £'¢ YPest Location:
Documents ChUsersvegis\Documents
Save [ save form dataaf | Images
User templates A\ \Roaming\MicrosoftiTemplates
Language Embed linguistic| | Workgroup templates
AutoRecover files Reaming MicasoftiWord
Ease of Access Toals Microsoft Office\ioot\Office16
E=E 5 Microsoft\Word\STARTUP
Advanced
[ Confirm file fon
Customize Ribbon Update automati
Quick Access Toolbar [ Allow opening 3
Ad-ins
[ Show add-in use

Trust Center Mailing address: The defautt location is treated as 3 trusted source for opening files. I you
change a location, make sure that the new location is secure,

File Locations.

ok
Layout options for: ey

-

GAMBAR 92. MENU STARTUP FILE MICROSOFT WORD

f. Setelah itu akan tampil layar folder Startup yang terlihat masih ko-
song.

g. Klik kanan pada halaman kosong tersebut - Paste, setelah itu akan
tampil menu konfirmasi seperti pada Gambar 89.

General [ prormipt before sa BB Modify Locatio
Always create b
Display ! B away “E“JM 4 [} % Microsoft > Word > STARTUP v W 0
= Replace or Skip Files - be
e
Copying 1 item from install to STARTUP Naifia - Daté iodi

The destination already has a file named "Zotero.dotm”
Na items match your search.
v Replace the file in the destination
*2 Skip this file

4 Compare info for both files

More details

T Wanmag sgaress T TT —WInaoWS (G

GAMBAR 93. MENU KONFIRMASI PASTE FILE ZOTERO MACRO

h. Pilih Replace the file in the destination.
i. Klik OK untuk keluar dan mengakhirinya.
j. Tutup Microsoft Word Anda, kemudian buka kembali.

Jika Anda melakukannya dengan benar, Add-ons Zotero akan tampil
pada menu utama di bagian atas halaman Microsoft Word.
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2. Menampilkan Add-ons pada Microsoft Word Versi Terbaru

Cara mengatasi masalah Add-ons pada Microsoft Word versi terbaru
berbeda dengan versi yang lama. Caranya lebih sederhana, dan tidak se-
rumit versi lama. Untuk mengatasinya ikuti langkah berikut:

a. Buka aplikasi Microsoft Word Anda.
b. Klik menu File > Options > Add-ins

c. Pada bagian bawah laman Add-ins ada kolom Manage - pilih Word
Add-ins 2> Klik GO

Procfing Add-ins
e Nome -
rtTo o
berigiinge Telephone Number (XML}
Ease of Access Zotero.dotm
Advanced

Inactive Application Add-ins

ActionsPane Schema for Add-Ins
Customize Ribbon L \AppD.

) ppDate\Local\Temp Templat wyw.dotm
Quick Access Toolbar G\ A ocalTemp Templats niife Cwyw.dotm,
c acalTemp Templat foyw.dotm
Add-ins c ocalTemp Templat; ot Online Cuyw.dotrm
cal LocahTemp Templat nline Cuyw.dotm
TistiCenter cal Local\ Templat OnlingGwyw.dotm
\Locs\Temp Templat wyw.detm
Templat
Templat
cal Templat
AU Local\ Ternplat Cywdotm
c \Local\ Templat Mote Online Curyw.dotm
=
Adg-in: Date (XML)
Publizher.  Microscft Corporation
Compatibiitys No compatibilty information availsble
Location:  CA\Program Files\Common Files\Microsoft Shared\Smart Tag\MOFLOLL
Description:  Additional actions specifiee inlst description files.
Manage: | Word Add-ins | e,

GAMBAR 94. MENU ADD-INS MICROSOFT WORD

d. Setelah itu akan tampil menu Templates and Add-ins,

seperti pada
Gambar 91.

Temnplates and Add-ins

O X
Templates XML Schema XML Expansion Packs  Linked C55
Document template
|Marmat Attach...
D Automatically update document styles
Attach to all new e-mail messages
Global templates and add-ins
Checked items are currently loaded.
[®&[Mendeley-1.18.dotm ~ Add...
Zotem.dutm
[_] EndMote Cuyw.datm e
D EndMote Online Cwyw.daotm

[_1EndMate Cwyw.dotm

[_]EndMate Online Cugyw.dotm

Full path:  CA\.\Microsoft\Word\STARTUP\Mendeley-1.18.dotm

Organizer... Cancel
GAMBAR 95. MENU TEMPLATE ADD-INS
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e. Aktifkan/centang Zotero.dotm > OK
f.  Tutup Microsoft Word Anda, setelah itu buka kembali

Jika Anda melakukannya dengan benar Zotero Add-ons akan tampil
pada menu utama Microsoft Word.

B. WORD COULD NOT COMMUNICATE WITH ZOTERO

Masalah ini muncul pada saat Anda mensitasi menggunakan menu
Add/edit Citation Zotero di Microsoft Word. Pesan kesalahan yang tampil
seperti terlihat pada Gambar 92.

Microsoft Word X

Word could not communicate with Zotero. Please ensure Zotero is nk
running and try again. If this problem persists, see
https:/fwww zotero.org/support/word_processor_plugin_troubleshooti A
ng

GAMBAR 96. PESAN ERROR ZOTERO

Masalah seperti ini sering terjadi. Banyak pengguna Zotero yang panik
dan kebingungan menghadapinya, padahal masalahnya cukup sederhana.
Pesan ini muncul karena aplikasi Zotero Anda belum terbuka saat men-
sitasi. Untuk mensitasi menggunakan Zotero aplikasinya harus terbuka
terlebih dahulu, supaya referensi yang akan dikutip bisa dicari dan diambil.
Cara mengatasinya cukup buka aplikasi Zotero Anda, mulailah mensitasi,
masalahnya langsung selesai.
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Add/edit bibliography: Salah satu menu pada Microsoft Word Add-ins
yang digunakan untuk membuat daftar pustaka.

Add/edit citation: Salah satu menu pada Microsoft Word Add-ins yang
digunakan untuk mengentrikan referensi yang akan disitasi.

Anotasi: catatan yang dibuat oleh pengarang atau orang lain untuk me-
nerangkan, mengomentari, atau mengkritik teks karya sastra atau
bahan tertulis lain.

Bibliografi: Biasa disebut dengan daftar pustaka, atau daftar referensi
yang dijadikan rujukan dalam sebuah penulisan.

Citation Style: Gaya atau format penulisan yang digunakan untuk mengu-
tip dan memberikan sumber informasi untuk tugas tertulis maupun
publikasi ilmiah.

Collections: Kumpulan referensi yang dikumpulkan di dalam akun Zotero.

Document preferences: Salah satu menu pada Microsoft Word Add-ins
yang digunakan untuk mengelola citation style.

Export Library: Fitur untuk menyalin daftar referensi yang tersimpan di
Zotero untuk bisa digunakan oleh orang lain, baik pada aplikasi Zotero
maupun aplikasi lain.

Folder: Merupakan media untuk mengelompokkan atau mengategorikan
referensi yang disediakan oleh Zotero untuk memudahkan dalam
mengelola referensi.

Groups: Fitur pada Zotero yang memungkinkan pengguna untuk berkola-
borasi dengan rekan lain sesama anggota penelitian untuk mengelola
referensi secara bersama-sama atau berkelompok.
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Highlighting: Fitur pada Zotero untuk menyorot atau memberi warna pada
teks.

Identifier: Salah satu metode untuk mengimpor referensi menggunakan
nomor identitas koleksi seperti: ISBN, DOI, arXiv ID.

IEEE: Format atau gaya kutipan atau yang dibuat oleh Institute of Electri-
cal and Electronics Engineers (IEEE) yang digunakan secara luas di
bidang teknik, ilmu komputer, dan bidang-bidang terkait.

Import Library: Menu untuk menambahkan referensi baru ke dalam akun
Zotero yang berasal dari aplikasi lain, atau koleksi milik pengguna
Zotero lain.

Manajemen Referensi: Merupakan proses mengumpulkan, mengorgani-
sasikan, dan mengelola referensi atau sumber daya informasi yang
digunakan dalam penelitian, penulisan ilmiah, atau pekerjaan akade-
mik lainnya.

Metadata: Informasi terstruktur yang mendeskripsikan, menjelaskan, me-
nemukan, atau setidaknya menjadikan suatu informasi mudah untuk
ditemukan kembali, digunakan, atau dikelola.

Microsoft Word Add-ons: Program tambahan yang dapat diinstal untuk
memperluas kemampuan atau menambahkan perintah kustom dan
fitur khusus pada Microsoft Word.

My Library: Salah satu menu dalam Zotero tempat pengguna mengelola
referensi yang dimiliki.

New Feed: Fitur yang disediakan oleh Zotero untuk membuat feeder, yaitu
pembaruan informasi pada situs yang dilanggan.

Note: Catatan yang dibuat tentang isi dari sebuah referensi.

Plugin: Software atau perangkat lunak yang menambahkan fitur tertentu
pada suatu program tanpa mengharuskan Anda mengubah program
itu sendiri.

Referensi: Sumber acuan, rujukan, petunjuk, atau buku-buku yang dian-
jurkan oleh dosen untuk dibaca oleh mahasiswa.

Related: Referensi yang topiknya berhubungan dengan salah satu refe-
rensi yang sedang dilihat atau dibaca.

Sinkronisasi/Sync: Menyesuaikan atau menyelaraskan data referensi
yang ada dalam aplikasi Zotero dengan akun Zotero pengguna.

Sitasi: Referensi atau kutipan yang memungkinkan kita untuk mengakui
sumber-sumber yang telah dikutip.

Subscription: Model bisnis berlangganan.

82



DAFTAR ISTILAH

Tag: Label atau penanda yang membantu memudahkan pembaca dalam
menemukan konten sebuah tulisan.

Unlink Account: Memutuskan koneksi antara aplikasi dengan akun Zotero

Unsubscribe: Memutuskan atau membatalkan berlangganan.

Upgrade storage: Fitur yang disediakan oleh Zotero untuk meningkatkan
kapasitas penyimpanan akun pengguna.

Web Library: Halaman pada akun Zotero tempat mengelola dan menam-
pilkan koleksi yang dimiliki oleh pengguna.

Zotero Connector: Konektor Zotero pada sebuah browser yang digunakan
untuk menyalin konten yang ada dalam sebuah situs web.

Zotero Preferences: Menu pada Zotero yang digunakan untuk mengatur,
dan mengelola aplikasi.
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LAMPIRAN

TUTORIAL MASTERING ZOTERO

Untuk memudahkan Anda dalam mempelajari, dan memahami ten-
tang aplikasi Zotero, penulis sudah membuatkan versi digital dari materi
yang ada di dalam buku ini dalam bentuk video tutorial singkat yang
membahas poin-poin penting dari materi yang ada di dalam buku Maste-
ring Zotero: Panduan Komprehensif Manajemen Referensi untuk Penelitian
dan Penulisan Karya Ilmiah. Penyajian materi dalam bentuk audio visual,
akan membantu Anda dalam mempelajari Zotero dengan cara yang lebih
mudah dan menyenangkan.

Seluruh materi disajikan secara lengkap dan berurutan dalam sebuah
website. Sehingga pengguna bisa mempelajarinya secara bertahap dan
terstruktur. Pembahasan dalam versi digital dikelompokkan ke dalam 2
bagian, yaitu: teori, dan tutorial penggunaan aplikasi. Teori membahas
tentang karakteristik, manfaat, kelebihan, dan kekurangan, serta perbeda-
annya dengan aplikasi manajemen referensi lainnya. Sedangkan tutorial,
membahas tentang teknis penggunaan aplikasi, mulai dari proses down-
load, instalasi, pencarian dan impor referensi, manajemen referensi, sitasi
dan bibliografi, kolaborasi/grup, serta troubleshooting.

Tutorial Mastering Zotero versi digital bisa diakses melalui link: http-
s://s.id/zotero-uda-andi atau bisa di-scan menggunakan QR Code berikut:

GAMBAR 97. QR CODE WEBSITE TUTORIAL ZOTERO
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Setelah itu Anda akan dibawa ke halaman web Uda Andi yang berisi
kumpulan tutorial Zotero. Selain menonton melalui halaman web tersebut,
Anda juga bisa menikmatinya melalui laman YouTube. Seluruh konten vi-
deo yang disajikan bersumber/tersimpan di dalam akun YouTube UdaAndi
(https://www.youtube.com/@AndiSaputra-hqlls). Semuanya bisa Anda
tonton sepuasnya, kapan pun, dimana pun, dan dari mana saja. Konten
yang tersaji di laman web tersebut akan terus diperbaiki, dan di-update
sesuai dengan kebutuhan, dan keinginan pengguna. Seluruh pembaruan,
dan tambahan konten tersebut bisa Anda nikmati secara gratis, tanpa ada
syarat apapun. Berikut disajikan cuplikan dari halaman website Mastering
Zotero.

@ | ®cusersat Gllustasivc ® teoriVser @203 O @What: G Gmail & Tuges-c [senin() & stedas  EuDAAX Ok QReoder v - X
< © QO B https//sites.googlecom/d/1 UZhR:OwxDaYkvITyCz CcongQl-rkvUPHRWC B enl i QL e RR S =

l;’ UDA ANDI SAPUTRA Home  Totero s Mendel

TUTORIAL ZOTERO

Zotero merupakan tools manajemen referens yang sangat populer di kalangan perelit,mahasiswa, dan profesional dar berbagai disiplin
iimu. Pengg.na dapat dengan mudah menyimpan, mengatur, mencari, dan menguip referensi mereka dalam berbagai format penulisan.
Ini adalah alatyang andal untuk mengelola efesensi dalam era igital .

-, B
Y% Tips & Trik Zotero - Pengant.. i

PENGANTAR ZOTERO PANDUAN DOWNLOAD & INSTAL DIREKTORI PENYIMPANAN ZOTERO “

ZOTERO

GAMBAR 98. TAMPILAN HALAMAN TUTORIAL WEBSITE ZOTERO
Selamat menikmati, semoga bermanfaat, dan jangan lupa subscribe,

like, dan share konten YouTube UdaAndi, supaya saya tetap bersemangat
dalam membuat konten-konten baru yang bermanfaat.
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